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tware is subject to the terms and conditions 
nge without notice and may not necessarily 
dditional charge. Subscriptions to online 
uire prior arrangements with participating 

and Sony Corporation (hereinafter referred 
 computer system (the SONY HARDWARE). 
 with this EULA (the SONY SOFTWARE). By 
. You may use the SONY SOFTWARE only in 

tware License Agreement (the Third Party 

poration, shall be covered by the Third Party 

r with the SONY HARDWARE to the place 

ony. This EULA allows you to use the SONY 
y to make one copy of the SONY SOFTWARE 
s first

Read this first

Notice
This product contains software owned by Sony and licensed by third parties. Use of such sof
of license agreements enclosed with this product. Software specifications are subject to cha
be identical to current retail versions. Updates and additions to software may require an a
service providers may require a fee and credit card information. Financial services may req
financial institutions.

© 2002 Sony Corporation. All rights reserved.

Reproduction in whole or in part without permission is prohibited.

End user software license agreement
This End User Software License Agreement (the EULA) is a legal agreement between you 
to as Sony), a corporation organized under Japanese Law, the manufacturer of your Sony
Please read this EULA carefully before installing or using the software distributed together
installing or using the SONY SOFTWARE, you agree to be bound by the terms of this EULA
connection with the use of the SONY HARDWARE. SONY SOFTWARE is licensed; not sold.

Notwithstanding the foregoing, software distributed together with separate End User Sof

EULA), including but not limited to Windows® operating system provided by Microsoft Cor
EULA.

If you do not agree to the terms of this EULA, please return the SONY SOFTWARE togethe
where you obtained it.

1. License. This SONY SOFTWARE and the related documentation are licensed to you by S
SOFTWARE for your personal use for a single SONY HARDWARE outside a network and onl
in machine-readable form for back-up purposes only.
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ry material. In order to protect them, and 
mble the SONY SOFTWARE in whole or in 

 and prior agreement of the recipient to be 
ARE and its copy to any third party.

 to be free from physical defects for a period 
 the applicable warranty period, Sony will 

perly packaged to the place where you 
ave no responsibility to replace media 
her representations, conditions and 

ims all other warranties and all conditions 
ity and fitness for a particular purpose. The 
e consumer, neither do they limit or exclude 

y time by destroying the SONY SOFTWARE, 
out notice from Sony, if you fail to comply 
, related documentation, and all copies 

 laws of Japan.

 to the Customer Service Guide on how to 
s first

2. Restrictions. The SONY SOFTWARE contains copyrighted material and other proprieta
except as permitted by applicable law, you may not decompile, reverse engineer or disasse
part. Except for the transfer of the SONY SOFTWARE together with the SONY HARDWARE
bound by the terms and conditions of this EULA, you may not sell or rent the SONY SOFTW

3. Limited Warranty. Sony warrants the media on which the SONY SOFTWARE is recorded
of ninety (90) days from the date of purchase as evidenced by a copy of the receipt. During
replace free of charge such media proved to be defective, provided they are returned pro
obtained it, together with your name, address, and proof of date of purchase. Sony will h
damaged by accident, abuse, or misapplication. The above limited warranty replaces all ot
warranties, whether express or implied, by statute or otherwise and Sony expressly discla
including, but not limited to, the implied warranties and/or conditions of satisfactory qual
terms of this limited warranty do not affect or prejudice your statutory rights as an ultimat
any liability for death or personal injury caused by the negligence of Sony.

4. Termination. This EULA is effective until terminated. You may terminate this EULA at an
related documentation, and all copies thereof. This EULA will terminate immediately with
with any provision of this EULA. Upon termination you must destroy the SONY SOFTWARE
thereof.

5. Governing Law. This EULA shall be governed by and construed in accordance with the

Should you have any questions concerning this EULA or this limited warranty, please refer
contact VAIO-Link.
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® guidelines for energy efficiency. The 

at promotes energy saving through the use 
ination of products with functions that 

can participate voluntarily. The targeted 
. Their standards and logos are uniform 
s first

ENERGY STAR®

As an ENERGY STAR® Partner, Sony has determined that this product meets the ENERGY STAR

International ENERGY STAR® Office Equipment Program is an international program th
of computers and their office equipment. The program backs the development and dissem
effectively reduce energy consumption. It is an open system in which business proprietors 
products are office equipment such as computers, displays, printers, facsimiles and copiers
among participating nations.

ENERGY STAR is a U.S. registered mark.
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ker, Smart Capture, SonicStage, Sony 
mory Stick Formatter, VAIO and the VAIO 
go are registered trademarks of Microsoft 
s first

Trademarks
Sony, DigitalPrint, DVgate, i.LINK, Jog Dial, PictureGear, PictureToy, PowerPanel, MovieSha
Notebook Setup, UI Design Selector, VisualFlow, Memory Stick, the Memory Stick logo, Me
logo are trademarks of Sony Corporation. The Windows and Windows 2000 Professional lo
Corporation.

All other trademarks are trademarks of their respective owners.

Specifications are subject to change without notice.
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ment to quality customer support 

ums, competitions, free downloads 

er, you can check the VAIO-Link 

the terms and conditions and refer 

guring your modem (page 90)).

aio/registration.asp.

nd the place where you live.
 your VAIO for the first time

Starting your VAIO for the first time

Registering your VAIO
It only takes a few moments to register your Sony VAIO computer.

By registering your computer, you can take advantage of Sony’s commit
and receive the following benefits:

❑ Club VAIO – Online support, tutorials, tips and tricks, news, news for
and software updates.

❑ VAIO-Link – If you are experiencing any problems with your comput
website for a possible solution: http://www.vaio-link.com.

❑ Guarantee – Protect your investment. See the Guarantee sheet for 
to your Customer Guide for more information.

To register your Sony VAIO computer, proceed as follows:

1 Connect your phone line and set up a modem connection (see Confi
2 Double-click the VAIO Online Registration icon on the desktop.

3 Select your language and click Next.
4 Select the Register Now option button and click Next.

You arrive on the website https://registration.sonystyle-europe.com/v

5 Fill in your first and last name, the serial number of your computer a

6 Click Submit.
Your VAIO is registered.

http://www.vaio-link.com
https://registration.sonystyle-europe.com/vaio/registration.asp
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icate as soon as you turn it on. This 
alled on your computer.

joyment out of your photographs 
Stick™. With DigitalPrint, you can 
make prints.

e Still, and DVgate Assemble. This 
them together into a professional-
and the computer operates as an 
and save the sequences in AVI and 
igital video images sent from a 
sible if you have DV In/Out on your 
 files on your hard drive.
e software on your computer

About the software on your computer
Your Sony computer is ready to help you work, play, learn, and commun
section gives you an overview of what you can do with the software inst

Sony software

DigitalPrint
Sony Electronics

DigitalPrint is easy-to-use software designed to help you get the most en
taken with a digital camera or taken from a CD, floppy disk or Memory 
easily load photos into your computer, create photo albums, labels and 

DVgate
Sony Electronics

DVgate is a kit of 3 complementary applications: DVgate Motion, DVgat
collection makes it easy to select and edit digital video clips, then bring 
looking home video. Use i.LINK™ to connect your digital video camera, 
editing desk that can capture, preview, cut and assemble your selection 
MPEG1 (and MPG2 depending on model) formats. DVgate Still displays d
digital videocassette recorder or a digital video camera recorder (only pos
camera or at least a DV Out for DV Gate Still), and saves them as graphic
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puter. In this application, you can 
ilot; you can also configure the Jog 
 e-mail, simply by turning and 
ure your i.LINK™ connections, and 

™. Use this software whenever you 
ory Sticks™ that can not be 
upports Memory Sticks™ with the 

emory Stick™ will be lost. If 

ial effects, background music, and 
aker® does the rest. You can also 
e exact clips order, special effects, 
ill automatically match the length 
e software on your computer

Jog Dial™ Utility
Sony Electronics

The Jog Dial™ utility allows you to configure the Jog Dial™ on your com
select the Sony applications, or others, that you want the Jog Dial™ to p
Dial™ to start any application, establish a dial-up connection, or read an
pressing the Jog Dial™. Finally, the Jog Dial™ utility allows you to config
to set a timer that can launch any application at a specific time.

Memory Stick Formatter
Sony Electronics

Memory Stick Formatter is special software for formatting Memory Sticks
reformat Memory Sticks™. Moreover, you may be able to reformat Mem
identified on Windows by using this software. Memory Stick Formatter s
following capacities: 4, 8, 16, 32, 64 and 128 MB.
When you format Memory Sticks™ with this software, all data on the M
necessary, take a backup of your data before formatting.

MovieShaker
Sony Electronics

MovieShaker® creates personal movies - complete with transitions, spec
text. All you do is import your clips, pick the tune you want and MovieSh
choose to take control and produce your very own movie. You choose th
and transitions. You can also import your own music and MovieShaker® w
of the song to the length of your movie.
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kgrounds, wallpapers, slide shows, 
al screen savers... You can even 

ovies in a variety of formats. You 
a Web page.

l. As well as drawing from scratch, 
 to pictures is just as much fun as it 

er and provides key information 
lects the most appropriate profile, 
of use.
e software on your computer

PictureGear
Sony Electronics

Create your own environment with the Digital Image Library (photos, bac
etc). PictureGear is your assistant for creating and implementing person
animate your preferred gif files with Gif Animation Tools, or play back m
can also create albums from your favourite images and upload them to 

PictureToy
Sony Electronics

PictureToy is Sony’s drawing application, using a highly accurate pen too
you can edit images using over 70 images. Adding spectacles and flowers
sounds!

PowerPanel
Sony Electronics

The PowerPanel utility controls the power management of your comput
about system activity and battery life. Automatic power management se
depending on the application you are working with and the conditions 
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o clips, which you can view or send 
d allows you to adjust the settings 
™ compatible devices or create a 

tion technology developed by Sony 
sic data on a personal computer. 

 technology allows it to be played 
onicStage technology is to create 

distributed without subsequent 

oaded to a personal computer by 
 Internet.

ces for system behavior, and set up 
e software on your computer

Smart Capture
Sony Electronics

Connect a digital camera to your computer to shoot still images and vide
by e-mail. The Smart Capture Finder displays images from the camera an
or create effects. Smart Capture enables you to capture images via i.LINK
panorama picture using the panorama assist function. 

SonicStage
Sony Electronics

SonicStage is software using the OpenMG technology, a copyright protec
Corporation and designed to allow recording and playback of digital mu
Once the data is encrypted and recorded onto the hard disk, SonicStage
back on the PC but prevents unauthorized distribution. The purpose of S
an environment in which larger quantities of high-quality music can be 
unauthorized distribution of the music files.
The SonicStage software encrypts and manages music files either downl
using the EMD services or adopted (or created) from your own CD or the

Sony Notebook Setup
Sony Electronics

Use Sony Notebook Setup to consult system information, specify preferen
a power-on password for your Sony computer.
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th UI Design Selector.

ur Memory Sticks™ (optional), your 
ll movie, sound and image files. in 
und files within VisualFlow or with 

tware shipped with your computer 
d. Reinstalling an individual device 
without you having to recover the 

her Sony PC or other manufacturer's PC.
e software on your computer

UI Design Selector
Sony Electronics

You can change the window design of the Sony software compatible wi

VisualFlow
Sony Electronics

VisualFlow allows you to browse interactively through the contents of yo
hard drive, or any other drive on your computer. VisualFlow can display a
a variety of ways, and allows you to play / display still images, movies or so
other software.

Product Recovery CD-ROMs
Sony Corporation

The Product Recovery CD-ROMs allow you to reinstall the system, the sof
and the bundled device drivers if they are corrupted or accidentally erase
driver may correct a problem you are experiencing with your computer, 
entire system.

! You can only use the Recovery CD-ROMs on the Sony computer you purchased, and not on any ot
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ware

tegrating tightly with the Internet 
m diagnostics and maintenance.
mproved support of the latest 
al of peripheral devices, and the 

troduced with Windows® NT. At 
 Windows-based applications and 

the World Wide Web. The Setup 
ce provider. A full e-mail package 
e Internet. NetMeeting, Outlook 

ith Internet Explorer 6.0. Internet 
f protection for all your Internet 
e software on your computer

Operating system and other pre-installed soft

Windows® 2000 Professional (Service Pack 2)
Microsoft Corporation

Microsoft® Windows® 2000 SP2 makes your computer work better by in
and networks and providing better system performance and easier syste
With Windows® 2000 SP2, your system takes better advantage and has i
graphics, sound, and multimedia technologies. Easy addition and remov
convergence of the TV and PC in your home are also featured.
This exciting operating system is built on the groundbreaking features in
the same time, Windows® 2000 SP2 maintains the best support for older
technologies.
For questions and technical assistance, go online to:

http://support.microsoft.com/directory

Internet Explorer 5.5
Microsoft Corporation

Internet Explorer is the Microsoft Internet browser allowing you to surf 
Wizard configures your computer to connect automatically to your servi
enables you to send and receive mail - including attached files - across th
Express and Microsoft Chat are just some of the components bundled w
Explorer 6.0 also includes 128-bit encryption, the highest possible level o

http://support.microsoft.com/directory
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omplete online tutorial helps new 

onic documents in Adobe Portable 
e the conformity of documents 
ed, you can open and view PDF files 
ML file. You quickly see the first 

r own CDs. Users can create their 
 can also create your own backup 

e files that you wish to write, and 
 format. After dropping them, 
e software on your computer

communications, including credit card use and financial transactions. A c
users become comfortable using the Internet.
For questions and technical assistance, go online to:

http://support.microsoft.com/directory

Adobe® Acrobat® Reader 5.0
Adobe Systems Incorporated

Acrobat® Reader software allows you to view, navigate, and print electr
Document Format (PDF), an open file format that is intended to preserv
created on all major computer platforms. Once Acrobat® Reader is install
from within your Web browser by clicking a PDF file embedded in an HT
page while the rest of the document is being downloaded.
For questions and technical assistance, go online to:

http://www.adobe.com

Drag'n Drop CD
DigiOn / Easy Systems Japan

Drag'n Drop CD is designed to be the most simple software to make you
own audio CDs or data CDs that can be read in most PCs. Drag'n Drop CD
CD from the original CD that you own. The operation is simple: select th
drag and drop them into an appropriate box that corresponds to the CD
simply press the CD Create button.
For questions and technical assistance, go online to:

http://www.easy.co.jp/dde/sony

http://support.microsoft.com/directory
http://www.adobe.com
http://www.easy.co.jp/dde/sony
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d virtual reality come alive for your 
 at:

and RealJukebox.

cess 2,500 radio stations featuring 
://www.real.com

s you build, manage, and play your 
, see the website at: 

hard disk, on external devices linked to your VAIO, 

er Licensing Agreement, go to Start > Programs 

ibution services that are supported by OpenMG.
ed-out to MagicGate Memory Stick™ or Sony 

.
ing site: http://www.openmg.com
e software on your computer

QuickTime 5.0
Apple

QuickTime is the Apple technology that makes video, sound, music, 3D an
Internet browser and Windows. For further information, see the website

http://www.apple.com/quicktime

Real Entertainment Center
Real Entertainment Center contains two software programs: RealPlayer 

RealNetworks - RealPlayer

RealPlayer is the RealNetworks video and audio player, which lets you ac
music, news and sports. For further information, see the website at: http

RealNetworks - RealJukebox

RealJukebox is your personal music management system. RealJukebox let
digital music library on your personal computer. For further information

http://www.real.com

✍ Important notice about RealJukebox and OpenMG Jukebox:
- Please do not use OpenMG Jukebox and RealJukebox at the same time. Music files saved on the 
or on a MagicGate Memory Stick™ may become damaged and unable to playback.
- Please read the End User Licensing Agreement before using RealJukebox. To view the End Us
> Real > RealJukebox > RealJukebox License Agreement.
RealJukebox does not support the Digital Rights Management (DRM) compliant online music distr
- DRM compliant music files downloaded from online music distribution services, cannot be check
portable devices using RealJukebox.
- If you want to take advantage of these DRM secure music services, please use OpenMG Jukebox
For details concerning the music distribution services supported by OpenMG, please visit the follow

http://www.real.com
http://www.apple.com/quicktime
http://www.real.com
http://www.openmg.com
http://www.easy.co.jp/dde/sony
http://www.real.com


A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

About th

14

n N

ive)

uses, and quarantine infected files 
bmitted to SARC are analyzed and 
gure Norton AntiVirus adequately, 
cords for viruses at system startup, 
ives for viruses once per week, and 
 virus in action. It can also scan files 
 when you use them.
 prompted to update the virus 
 left the factory.

s all the features you would expect 
anced functionalities, full precision 
u can play DVD movies, interactive 
cally determines the type of disc in 
e software on your computer

Symantec Norton AntiVirus (as setup on the hard dr
Symantec

With Norton AntiVirus, you can scan files, folders, or entire drives for vir
for submission to the Symantec AntiVirus Research Center (SARC). Files su
the results are reported automatically within seven days. When you confi
your computer is safe. Norton AntiVirus can automatically check boot re
check programs for viruses at the time you use them, scan all local hard dr
monitor your computer for any activity that might indicate the work of a
you download from the Internet and check floppy disks for boot viruses
You must launch the Norton AntiVirus installation, and you will then be
definitions. This is normal as new viruses have come out since your VAIO
For more information, see the online help files and the website at:

http://www.symantec.com/techsupp

WinDVD
InterVideo, Inc.

InterVideo Inc.'s WinDVD is a simple-to-use DVD player. WinDVD combine
to find on a standard consumer DVD player, in addition to some very adv
video decoding, a choice of user interfaces, and video display options. Yo
DVD titles, MPEG video content, video and audio CDs. WinDVD automati
the DVD drive and uses the correct playback method.
For questions and technical assistance, go online to:

http://www.intervideo.com

http://www.symantec.com/techsupp
http://www.intervideo.com
http://www.openmg.com
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deo software

Using Video software
The following video software applications are installed on your VAIO:

❑ Using DVgate (page 16)

❑ Using MovieShaker (page 31)

❑ Using Smart Capture (page 37)

http://www.intervideo.com
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dit images taken with digital video 
nal computer. It also gives you the 

 and a DV device.

on when recording edited video. Please make sure 
g. To configure your computer to use DVgate, refer 
deo software

Using DVgate
DVgate is a software application that enables you to capture and then e
devices (DV devices), such as digital video camera recorders, on your perso
ability to output the edited material for recording on a DV device.
With DVgate, you can easily perform image editing with your computer

DVgate consists of 3 applications:

❑ DVgate Motion;
❑ DVgate Still;
❑ DVgate Assemble.

✍ Depending on the computer settings, frames may be lost during video capture and frame duplicati
you configure your computer according to the recommended settings to prevent this from happenin
to the Online help of DVgate.
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 a DV device.

f the images recorded on a DV 
n specify the exact scenes that you 
ou can then choose to save the 

 digital video camera recorder*, 
ording single clips, but you can 

n on the camera.

-down list.
ard the tape to the selected time 
deo software

Using DVgate Motion
With DVgate Motion you can capture video and record edited videos on

❑ Capturing video:
You can automatically or manually capture any scene or portion o
device, such as a digital video camera recorder. What is more, you ca
want to capture while watching the tape playback on the monitor. Y
selected scenes as separate files or as one file.

❑ Recording edited video on a DV device
You can record the edited video on tape using a DV device, such as a
connected to the computer. With DVgate, you are not limited to rec
record a series of clips on the DV device at one time.

To launch DVgate Motion, proceed as follows:

1 Connect the camera to the computer with the i.LINK™ cable and tur

2 Click Start, Programs, DVgate, DVgate Motion.
DVgate Motion and the Monitor windows appear.

* The digital video camera recorder must have a DV-IN connector.

Capturing video

You can automatically or manually import videos onto your computer.

To automatically import videos onto your computer, proceed as follows:

1 Launch DVgate Motion.

2 Click the down arrow and select Import-Auto from the Mode drop
Use the DVgate camera controls buttons to play, rewind or fast forw
code to begin capturing.
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Out list window.

Out list window.

 All to import them all at once.
deo software

 

3 Press Play to start the video.
The video begins to play in the Monitor window.

4 Click Mark to mark the beginning of the first segment.
The first frame of the segment to be captured, is displayed in the In/
Click Mark again to mark the end of the segment to capture.
The last frame of the segment to be captured, is displayed in the In/
Continue to mark as many segments as you want.

5 Click Capture to import the selected video segment or click Capture
The Save as a file window appears.

6 Select the location to save the file.

7 Click the Save button.
DVgate captures the segments.
The Capturing complete message appears.
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indow.

ame video sequences later on, or 

 video from or to a tape.

 values. Adjustment of the 
ice recording. You can choose to 
ing the automatic calibration 
sually correct.

ws:

p-down list.
deo software

8 Click OK in the DVgate Motion window to finish.
Information about the capturing process is displayed in the Report w

9 Click OK.

10 Exit DVgate Motion.
The Dvmotion2 window appears on the screen.
You can then save the In/Out list, which allows you to capture the s
change the In/Out settings.

✍ Make sure that the camera is in Video Tape Recorder mode (VTR) when capturing or playing back

If you want to manually import video onto your computer, refer to the DVgate online help file.

Recording edited videos on a DV device

To record edited videos on a DV device, proceed as follows:

1 Adjust the recording correction values.

2 Add files to the Record List.

3 Record remotely or manually the video on the DV device.

Adjusting the recording correction values

To ensure accuracy in the recording, you can specify recording correction
recording correction values is especially important when performing spl
specify the values yourself or to have them automatically adjusted by us
feature. The values generated by the automatic calibration feature are u

To automatically adjust the recording correction values, proceed as follo

1 Launch DVgate Motion.

2 Click the down arrow and select Export - Auto from the Mode dro
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 finds the adjustment values.

s, time code, file length and file 

s saved with the same name. Serial numbered 
emble.

le.

ound (depending on the DV device) may occur at 

ng in different modes might cause sound or image 
e the order of the files, add or delete files.
deo software

3 Select Adjust on Recording… from the Settings menu.
The Adjust on Recording dialog box appears.

4 Click the AutoAdjust button.
DVgate Motion activates the connected DV device and automatically

5 Click OK.

✍ To manually adjust the recording correction values, refer to the DVgate online help file.

Adding files to the Record List

To add files to the Record List, proceed as follows:

1 Launch DVgate Motion.

2 Click Add in the DVgate Motion – AVI file list.
The Add dialog box appears.

3 Select a file and click Open.
The specified file is added and the serial number, first and last image
name are displayed.

★ DVgate Motion adds all serial numbered files with the same name if you select Add all divided file
files are created when you specify to save files as multiple files in DVgate Motion and DVgate Ass

✍ All newly added files are appended to the end of the list.

You can drag multiple files at one time; however, the order in which they are added is unpredictab

You can record AVI files with different sound modes on a DV device, but about one second of no s
the point where the sound modes change.

You can only add AVI files using DV Codec as video compression; MPEG files are not supported.

When recording a video sequence, make sure that all images are saved in the same mode. Recordi
distortions during playback. After adding the files you want to the Record List, you can still chang
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f the files, add or delete files.

on.

 button.

umbered.

 down the <Shift> or <Ctrl> key.

g or deleting (a) file(s).

e list window.

ct the file you want to preview.

 They are not for designed for navigation purposes 
elect only one file, Previous File and Next File 
deo software

After adding the files to the Record List, you can still change the order o

To change the order of the files in the Record List, proceed as follows:

1 Click the file you want to move while holding down the mouse butt

2 Drag the file to the appropriate position and then release the mouse

To remove a file from the Record List, proceed as follows:

1 Click the file you want to remove.

2 Click Delete.
The removed file is filled by the subsequent file and the files are ren
Click Delete All when to remove all files.

✍ You can select multiple AVI or still picture files from the Record List by clicking them while holding

When you move multiple files, they are all moved together.

You can undo changes by choosing Undo from the Edit menu immediately after inserting, movin

You can save a Record List for future use. Record List files can only be used in DVgate Motion.

To preview a clip, proceed as follows:

1 Select the file you want to preview in the DVgate Motion – AVI fil
2 Click Preview.

The Monitor window and the Preview window appear.
The Monitor window shows the first frame of the file.
Click on the Previous File button or on the Next File button to sele
Click Preview All to preview all the files shown in the list.

✍ Previous File and Next File are buttons for moving the preview from one selected file to another.
within the list. Consequently, you cannot click on them when only one file is selected. When you s
do not function.
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 a DV device.

eed as follows:

n on the camera.

-down list.

 and select the video file you want 

end option button in the Output 

ence during recording.
 during recording.
 of the video sequence during 

ber of frames in the Length box in 

 they are arranged in the Record 

e. Clicking Record will send only the video files 
deo software

Recording on the DV device

You can automatically or manually export videos from your computer to

To automatically export videos from your computer to a DV device, proc

1 Connect the camera to the computer with the i.LINK™ cable and tur

2 Launch DVgate Motion.

3 Click the down arrow and select Export-Auto from the Mode drop

4 Click the Add button in the DVgate Motion - AVI file list window
to export.

5 Click Record or Record All.
The Output dialog box appears.

6 Select the Add blank image option button.

❑ You can add blank frame(s) during recording if you select the App
dialog box.
Blank frame(s) can be placed in the following locations:
Head: A blank image is placed before the start of the video sequ
Tail: A blank image is placed after the end of the video sequence
Both: Blank images are placed before the start and after the end
recording.

❑ You can specify the length of a blank image by entering the num
the Output dialog box.

7 Click OK.
The Output dialog box closes and recording starts.
Video sequences are recorded on the DV device in the order in which
List.

★ Clicking Record All will send all the video files shown in the Record List  to the connected devic
selected from the Record List to the connected device.
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the recorded segment regardless of the settings. 

he video device through DVgate Motion.

Vgate Motion is recording. Never switch the input 

ine help file.

 DV devices such as a digital 
res them as still pictures.

creen of your VAIO.

s in the forward and backward 

 another application via the 

ces option. In the list that appears, click 
deo software

✍ Even if you specify not to add blank frames, several blank frames are always placed at the end of 
This is to prevent image noise from being recorded when recording stops.

Do not quit or log off from Windows® while recording. Otherwise, recording will fail.

Disable the screen saver in Windows®.

Do not start other applications or move any active window while recording.

Recording from the very beginning of the tape may not be successful if you record by controlling t

Do not turn the power switch on the digital video camera recorder to Camera or turn it off while D
sources when recording on a digital videocassette recorder as this might prevent recording.

If you want to export manually videos from your computer to a DV device, refer to the DVgate onl

Using DVgate Still
DVgate Still is an application that displays digital video images sent from
videocassette recorder or a digital video camera recorder and that captu
The following functions are featured:

❑ Control the connected DV device and display a video image on the s

❑ Capture 30 frames of still pictures in total with respectively 15 frame
directions.

❑ Capture only one frame of a still picture.

❑ Save a captured still picture in BMP, JPEG, GIF or DVF format.

❑ Save a captured still picture in the PictureGear* folder or copy it to
clipboard.

* To be able to save in the PictureGear folder, launch PictureGear. Click the Outer devi
Capture and then DVgate Still.

✍ The sound recorded with the image, is not played.
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 mode and the Single Frame 

s of still pictures in total with 
ill pictures already captured, are 
ame of a still picture.

auses.

e same even if you capture during 

rame overwrites the first frame of the still picture, 

ture mode, proceed as follows:

 in Continuous Capture mode.
in Single Frame Capture mode.
deo software

Capturing pictures

There are two capture modes in DVgate Still: the Continuous Capture
Capture mode.

❑ Continuous Capture mode:
If you capture pictures during Play mode, you can capture 30 frame
respectively 15 frames in the forward and backward directions. All st
lost. If you capture during Pause mode, you can capture only one fr

✍ Immediately after you capture during Play mode in Continuous Capture mode, the DV device p

❑ Single Frame Capture mode:
You can capture one frame of a still picture. The captured result is th
Play or Pause mode.

✍ Capturing 30 frames in Continuous Capture mode replaces all 30 frames. Capturing only one f
capturing the next frame overwrites the second frame, and so on.

To toggle between Continuous Capture mode and Single Frame Cap

1 Click Settings in the DVgate Still window.

2 Choose Capture…
The Capture Settings window appears.

3 Select the Capture frames continuously option button to capture
Clear the Capture frames continuously option button to capture 

To capture pictures, proceed as follows:

1 Connect the DV device to your computer.

2 Launch DVgate Still (Start/Programs/DVgate/DVgate Still).
The DVgate Still window appears.
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ore or after the current one.

n this case, exit all applications other than DVgate 
deo software

 

3 Set the DV device to the Play or Pause mode.
The video image appears in the Monitor window.

4 Click the Capture button.
The video image in the Monitor window is being captured.

✍ Dragging the slider in the Capture window to the left or right lets you display the still picture bef

! If you exit DVgate Still without saving the captured still picture, it is cleared.

! Even if you attempt to capture continuous pictures, you may not be able to capture some frames. I
Still and then retry to capture them.
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Saving the captured pictures

You can save the still pictures displayed in the DVgate Still - Still wind
formats: BMP, JPG, GIF or DVF.

To save the captured pictures, proceed as follows:

1 Launch DVgate Still and capture images.

2 In the DVgate Still - Still window, select a still picture you want to 
 

3 Click the Save button.
The Save As dialog box appears.
Use the Location to Save drop-down list to select a folder.
Select a file format from the File Format drop-down list.

4 Click Save.
The captured picture is saved.
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e file. You can save the resulting 

Afterwards you can always edit the 
files.
deo software

Using DVgate Assemble
DVgate Assemble enables you to edit video files and still image files cap
DVgate Still. Afterwards you can splice them together to form one singl
spliced video sequences as AVI, MPEG1, or MPEG2 format files.

To launch DVgate Assemble, proceed as follows:

1 Click Start.

2 Point to Programs, DVgate and then to DVgate Assemble.
The DVgate Assemble main window appears.

Creating an Assemble List

You can create an Assemble List with files you want to splice together. 
Assemble List by changing the order of the files and adding or deleting 

To add files to an Assemble List, proceed as follows:

1 Launch DVgate Assemble.
 

2 Click the Add button.
The Add dialog box appears.

3 Choose AVI file in the Files of type drop-down box.
If you select Add all divided files saved with the same name, 
DVgate Assemble will add all serial numbered files with the same 
name to the list. Serial numbered files are files that are created 
when DVgate Motion saves files that are split and applies 
consecutive numbers to them. The numbers of the split files have 
4 digits and increase one unit at a time starting with 0001.

4 Select a file and click Open.
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, and GIF formats.

e conversion mode are shown.

mble.

ant to use. For example, there is no 
 from a longer video sequence 
ing the exact scene is only enabled 
mand is disabled when more than 

o use, proceed as follows:

oint by clicking the Begin or End 

gin point.
of the dialog box.
point.
 the dialog box.
deo software

✍ Imported files are added to the end of the Assemble List.

You can only add video files of the AVI (DV CODEC) format, and still image files of the BMP, JPEG

When you add a still image file (BMP, JPEG, or GIF), the number of frames, converted size, and siz

You can save an Assemble List for future use. Assemble List files can only be used in DVgate Asse

Editing AVI files

You can edit the AVI files in the Assemble List for the exact scenes you w
need to recapture files even if you only want to use one particular scene
originally captured with DVgate Motion. Note that the process of remov
when one AVI file is selected from the Assemble List. However, this com
one file are selected.

To edit the AVI files in the Assemble List for the exact scenes you want t

1 Launch DVgate Assemble.

2 Select the AVI file you want to edit in the Assemble List.

3 Choose Edit a clip... from the Edit menu.
The DVgate Assemble - Clip dialog box appears.

4 Click the Preview button.
The video sequence of the selected file is played back.
You can move the playback position to the Begin point or the End p
point of the image.
Click the Begin button when you see the scene to be used as the Be
The Begin point image and the time code appear in the lower part 
Click the End button when you see the scene to be used as the End 
The End point image and the time code appear in the lower part of

5 Click OK.
The AVI file is edited.
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duction or enlargement.

to the maximum without changing 
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Combining still images with video images

To combine still images with video images, proceed as follows:

1 Launch DVgate Assemble.

2 Select the still image you want to insert from the Assemble List.

3 Choose Edit a clip... from the Edit menu in the main window.
The DVgate Assemble - Clip dialog box appears.

4 Enter the insertion time in seconds or frames.

5 Turn the Wide TV mode on or off.

6 Select the screen size.

7 Adjust the height and width of still images when they are output:

❑ Full size: Enlarges the screen size to the full monitor size. The as
selection.

❑ Original Size: Retains the original size of the image, without re

❑ Full size using aspect ratio as saved: Enlarges the screen size 
the aspect ratio.

8 Click OK.
The still and video images are combined.
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own in the lower part of the Save 

e of the file in the File name text 

ins.

 to an AVI file complete message.
 outputting an AVI file.

e connected and output as a file. Clicking Output 

attached to the file name, e.g., test001-0001.avi, 
deo software

Saving the edited video

To save an edited video sequence, proceed as follows:

1 Click the Output or the Output All button.
The Save As dialog box appears.
Information on the output file and the amount of free disk space is sh
As dialog box.

2 Select the location where you want to save the file and type the nam
box.

3 Click Save.

4 The Outputting as an AVI file dialog box appears and splicing beg

5 The DVassemble window appears and displays the Exporting/Save
The set time and the size that the file is split into are displayed when

6 Click OK.
The edited video is saved.

✍ When you click the Output button, only the files on the Assemble List that have been selected, ar
All means that all the files on the Assemble List are connected and output.

The file name is the name that was entered in the Save As dialog box. A 4-digit serial number is 
then test001-0002.avi, test001-0003.avi.
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Using MovieShaker
MovieShaker can be used to create fun and innovative movies without a
few steps, motion pictures can be combined with special effects, still ima
then saved in a format most computers can play.

To open MovieShaker, proceed as follows:

1 Click the Start button on the Windows® taskbar.

2 Point to Programs and then MovieShaker.
3 Click MovieShaker.
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ng the Shake, Capture, or 

long including background 

he DV device or MICROMV 
Clip tray. The monitor 
r MICROMV device.

ct tray, then it is displayed 
the effect from the Effect 

ration and Index tray. 
n button. Only when a 
OMV Device has been 

 Capture tray is displayed 

ed to a scene.

ed between scenes.

inserted into a movie.

MV device and imports 

vieShaker.

he Product tray, you will 

.

 music, and narration, and 
 of scenes, transitions, 
deo software

1. Menu bar Shows MovieShaker menus.

2. Monitor panel Contains the Shake, Capture, and Edit tray. Select a tray by clicki
Edit tab.

The Shake tray is for creating a scene of approximately 30 seconds 
music, using clips on the Clip tray at random.

The Capture tray is provided for capturing images directly from t
device connected to your computer, and importing them into the 
displays the images recorded on the videotapes of the DV device o

The Edit tray is for processing scenes. Click a scene on the Produ
on the Edit tray. You can add an effect to the scene by dragging 
tray and/or the Text tray and dropping it on the Edit tray.

3. Tool panel In the Tool panel, you will find the Effect, Text, Transition, Nar
Select a tray by clicking the Effect, Text, Transition, or Narratio
MICROMV device has been connected to your computer and MICR
selected from the Device menu, the Index tray appears while the
on the monitor panel.

The Effect tray contains various effects to be applied to a scene.

The Text tray provides a tool for creating a text effect to be appli

The Transition tray contains various transition effects to be insert

The Narration tray provides a tool for recording narration to be 

The Index tray provides a tool for capturing images from a MICRO
them into the Clip tray.

4. Clip tray The Clip tray is provided for placing clips to be processed with Mo

It can contain a movie file, still image and/or sound files.

5. Product tray The Product tray is where you arrange clips to make a movie. In t
find the Storyboard Display and the Timeline Display.

On the Storyboard, you can easily arrange scenes and transitions

On the Timeline, you can arrange scenes, transitions, background
make fine adjustments to the starting/ending points and duration
background music, and narration.
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d clips you want to use in your 

is only removes the clip from the tray, the original 

 the Shaker feature. Shaker 

.

oduct tray.
deo software

Importing images and sound clips
Before you can create a movie, you need to import the images and soun
movie.

To import images and sound clips, proceed as follows:

1 Click the File import button . 
The Import dialog box appears.

2 Select the file you want to add.

3 Click Open.
The file is added to the Clip tray.

✍ Importing files over 75 seconds in length may cause MovieShaker to stop responding.

To remove a clip from the Clip tray, drag it from the Clip tray and drop it on the trash icon . Th
file is not deleted.

Creating a movie
After adding clip(s) to the Clip tray, you can create a short movie using
randomly selects clips from the Clip tray to create a 30-second scene.

To create a movie, proceed as follows:

1 Click the Shake tab .

2 Select a mood by clicking a face in the Shaker tray 

3 Click the Shake button .
A thirty-second scene is automatically generated and saved to the Pr

To preview the created movie, proceed as follows:

1 Double-click the scene in the Product tray .

2 Press Play .
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✍ Scenes created with Shaker begin with a black frame. After processing, they are placed in the first

Limit the number of scenes in the Product tray to 5 or less.

MovieShaker may stop responding if there are too many scenes in the Product tray.
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 tab

re tab

b

 control slider

e control slider

 palette

in, fade-out

reen preview button

rimming range

t-play

ontrol buttons

ing range

s still image button

adjustment

or
deo software

Editing clips and scenes
You can edit your movie by adding effects and text, adjusting the color 
length of the clip.

 

  1. Shake

  2. Captu

  3. Edit ta

  4. Speed

  5. Volum

  6. Effect

  7. Fade-

  8. Trash

  9. Full-sc

10. Play t

11. Repea

12. Play c

13. Trimm

14. Save a

15. Time 

16. Monit
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he Edit tray monitor.

-files.

check them before saving them.
/MICROMV device, or uploaded to 

ovide better quality than Quick-Save, but will take 

ded: 1024x768/75 Hz or lower.
deo software

To edit clips and scenes, proceed as follows:

1 Double-click the clip in the Clip tray to move it to the Monitor Pan
2 Select the Effect tab from the Tool Panel.
3 Drag and drop the effect you want to add from the Effect tray to t

✍ To preview an effect, click the effect in the Effect tray in the Working Panel monitor.

For instructions on adjusting effect duration and replaying clips or scenes, consult the online Help

Saving a movie
You can save or export your final movie products. You can preview and 
Your final movie products can be saved as files, exported to a DV device
ImageStation.

To save your movie, proceed as follows:

1 Click the Export button .
The Export dialog box appears.

2 Select the format in which you want the document to be saved.

3 Click Next.

4 Select the folder in which you want to save the file.

5 Name the file.

6 Click Save.
Your movie is saved.

✍ Exporting movies may take a long time to complete. Saving movies with DV (Digital Video) will pr
longer.

MovieShaker can play AVI files up to 65 MB in size.

For DV playback and smooth video playback, the following resolution/refresh rates are recommen
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Using Smart Capture
You can use Smart Capture to shoot still images and record video clips fr
your computer.

Capturing still images
You can capture still images from i.LINK™ compatible devices.
To capture still images, proceed as follows:
1 Connect an i.LINK™ compatible device to your computer.
2 Launch Smart Capture from the Start menu, in Programs / Smart

The Finder window appears, displaying the image of the subject.
3 Adjust the focus on the subject.
4 Click the Capture button in the Smart Capture window.

The Still Viewer window appears.
The image you have captured, is displayed in the Still Image Displa

5 To end Smart Capture click the  button in the top right corner of
window.

✍ Make sure a camera is plugged to the i.LINK™ connector.
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 Viewer. You can display, save or 

 pixels.

 window may appear blurred.

ear blue.

message.

are. MAPI is a Microsoft® Windows program 
ocument you are working on to the e-mail note.
deo software

Displaying captured images in Still Viewer
To display captured images in Still Viewer, proceed as follows:

From the Start menu, select Programs / Smart Capture and click Still
delete your images or send them by e-mail.
To end Still Viewer, click the  button.

✍ You can capture still images in the following sizes: 640 x 480, 320 x 240, 160 x 120 and 80 x 60

When capturing a small resolution image (i.e., 80 x 60 pixels), the displayed image on the Finder

A gap may appear when a rapid-moving object is displayed. This is not a malfunction.

If you start Smart Capture while no camera is plugged, the Smart Capture Finder screen will app

You can capture still images and video clips from a digital video camera using Smart Capture.

Sending still images via e-mail
To send still images via e-mail, proceed as follows:

1 Launch Still Viewer.
2 Select the still image you want to send via e-mail, using  or .

3 Click Mail.
Your e-mail window appears with the selected file attached to your 

4 Send the e-mail.

✍ You need to set up MAPI (Messaging Application Program Interface) when using the e-mail softw
interface that enables you to send e-mails from within a Windows application and to attach the d
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lip.
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Shooting video clips
With a video camera connected to your computer you can use Smart Cap
as play them or send them via e-mail.

To capture video clips, proceed as follows:

1 Launch Smart Capture. 

2 Select Net Movie using the Switch Capture Mode button.
The image appears in the Finder.

3 Turn the camera towards the subject.

4 Adjust the image.

5 Click the Capture button to shoot a video clip (you can shoot up to 
settings you chose in the Recording options section).

6 Click the Capture button when finished.
The Movie Player window appears, it contains the captured video c

7 Click  to playback the images. Click  to pause,  to stop playback

8 To end Smart Capture, click .

✍ Make sure a camera is plugged to the i.LINK™ connector and turned on.

You can shoot video clips in the following formats:

Non-compressed:

- Video 160 x 120, 24 bits, max. 10 frames/sec.

- Audio PCM, 11.025 kHz, 16 bits, monophonic

Compressed:

- Video MPEG1 160 x 112, maximum of 30 frames/sec.).

- Audio MPEG1, 44.1 kHz (effective maximum equivalent to 11.025 kHz), monophonic.

A gap may appear when a rapid-moving object is displayed. However, this is not a malfunction.
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deo software

Sending video clips via e-mail
If you shoot a video clip in a low resolution format, its size will be small a
by e-mail.

To send video clips via e-mail, proceed as follows:

1 Launch Smart Capture.

2 Click Movie Player.
3 Click Mail.

The Compression Settings window appears.

4 Choose the compression rate by moving the slider.

5 Click Start Compression.
When compression is completed, you will be asked to attach the file 

6 Accept and send the e-mail.
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es while maintaining the copyright 
ge, it is encoded in ATRAC3 format 
ur computer or transferred to 
 and WAV format audio files into 

Ds by selecting the appropriate 
g audio files with SonicStage

Managing audio files with SonicStage
SonicStage lets you play and record audio CDs and import digital audio fil
information of the contents. When you record an audio CD with SonicSta
onto you computer’s hard drive. The imported data can be played on yo
external devices or media. SonicStage converts your existing MP3, WMA
ATRAC3 format.

To open SonicStage, proceed as follows:

1 Click the Start button on the Windows® taskbar.

2 Point to Programs, SonicStage and then click SonicStage.

3 The Please confirm setup dialog box appears.
You can set SonicStage as the default application for playing audio C
check box.

4 Click Yes.
The SonicStage main window appears.
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 feature.

p, fast-forward and reverse.

rrent feature tab.

ick the Go to URL link 

file tree view.
g audio files with SonicStage

 

1 Feature tabs Changes the screen view according to the selected

2 Player control buttons Controls playback functions, such as play, pause, sto

3 Playlist drop-down list Displays available playlists and audio files of the cu

4 File tree view Displays the folders available on your computer.

5 Internet address drop-
down list

Displays Internet addresses, if available. You can cl
button to immediately connect to web sites.

6 File list view Displays the contents of the folder selected in the 

7 Tutorial tab Opens and closes the Tutorial feature.
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o register with CDDB. You need Internet access on 
 click the Help button.

y offers no guarantee for creating CDs, an option 
nter problems when using this feature. Please visit 
rt information regarding all RealNetwork products, 
g audio files with SonicStage

✍ The CDDB® (Compact Disc Database) Music Recognition Service registration wizard enables you t
your computer to register and use this service. For more information regarding CDDB registration,

! Sony recommends the use of SonicStage version 1.1 when backing up or creating music CDs. Son
provided by RealJukebox2 Basic for Sony. There are some CD-ROM drives or drives that may encou
the RealNetworks website to get more detailed information regarding this issue. For general suppo
go to http://service.real.com.

http://service.real.com
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nicStage.

es from the tracks you do not want 
lect All check box, and then 

e recording is finished, the new 
n move to this feature view by 

timization dialog box appears. 

ering with CDDB.
g audio files with SonicStage

Recording a CD
You can record songs from audio CDs and import them to playlists in So

To record a CD, proceed as follows:

1 Insert an audio CD into your system’s optical disc drive.

2 Click the CD tab.

3 Use the drop-down lists to select the file format.

4 You can select specific tracks on your CD by deselecting the check box
to record. You can clear all selected tracks by selecting the empty Se
selecting the tracks you want to record.

5 Click the Rec to Jukebox button  to begin recording. When th
playlist appears in the File tree view of the Playlist window. You ca
clicking the Playlist tab.

✍ When you record from an audio CD on your optical disc drive for the first time, the CD Drive Op
Click Start to verify your optical disc drive. Once the verification is performed, recording begins.

You can display the name of the CD and its songs by clicking the CD Info button and after regist
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re and external devices or media 
 more information on using your 
duct.
ation on using the 2-step method, 

 external device (for example, a 

cGate Memory Stick™) into your 

ce or media and lists the content 
.

d in the center of the Transfer 

heck out more than one song at a 

song list of the external device or 

 manual.

ring the Check Out process.
ng audio files with SonicStage

Transferring songs (check in/out)
You can transfer songs between the playlists on your SonicStage softwa
(for example, Memory Stick™ Walkman, Network Walkman, CD-RW). For
external devices or media, see the documentation that came with the pro
These instructions are for using the check in/out 1-step method. For inform
read the SonicStage online Help-files.

Checking out songs
Checking out songs means transferring audio files from a computer to an
portable player).

To check out songs, proceed as follows:

1 Connect the external device or insert the media (for example, a Magi
computer.

2 Click the Transfer tab to display the Transfer window.
Your computer automatically recognizes the connected external devi
information in a new panel on the right side of the Transfer window

3 Select the playlist containing the song to check out.
The songs in the playlist are shown in the Playlist view panel locate
window.

4 From the Playlist view panel, select the song to be checked out. To c
time, hold down the <Ctrl> key and select additional songs.

5 Click Check Out or drag the song to the appropriate position in the 
media.
The checking out begins.

✍ SonicStage does not work with the blue Memory Sticks™. For more information, read the OpenMG

To cancel Check Out, click Stop, or click Cancel in the processing dialog box that is displayed du
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ernal device or to the hard drive. 

rive of the same computer from 

into your computer.

ce or media and lists the content 
.

ce or media. To check in more than 
l songs.

want to check in all the songs in 

ring the Check In process.
g audio files with SonicStage

Checking in songs
After checking out audio files, you can transfer those files back to an ext
This is what we call checking in.
The songs that you transfer like this can only be checked in to the hard d
which the songs were checked out.

To check in songs, proceed as follows:

1 Connect the external device or insert the MagicGate Memory Stick™ 

2 Click the Transfer tab to display the Transfer window.
Your computer automatically recognizes the connected external devi
information in a new panel on the right side of the Transfer window

3 Select the song to be checked in from the song list of the external devi
one song at a time, hold down the <Ctrl> key and click the additiona

4 Click Check In, or drag the song(s) to the Playlist view panel. If you 
the external device or media, click In All.
Check In begins.

✍ To cancel Check In, click Stop, or click Cancel in the Processing dialog box that is displayed du
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 the Tutorial. The user-friendly 

ic, graphics and information data 
 use the SonicStage Backup Tool.

s with various formats, such as MP3 
the Microsoft® Windows Media™ 
. Manage your audio files through 

e available when you register your 
n manage your music by creating 
 song list in the Playlist feature, 

lders. Edit your music by combining 
ing the Combine and Divide 

a smaller, compact version of the 
ith SonicStage while using other 

e design of the main SonicStage 
hich enhances the appearance of 
back operations only.
g audio files with SonicStage

Additional features
❑ SonicStage Tutorial – The features of SonicStage are described in

interface guides you directly through the SonicStage features.

❑ SonicStage Backup Tool – You can back up and restore all the mus
managed by SonicStage. You must be connected to the Internet to

❑ Import audio files in various formats – You can import audio file
or WAV standards. You can also import audio files that comply with 
Technologies (WMT) standard, identified by ASF or WMA extensions
the Playlist feature of SonicStage.

❑ Manage imported songs on the Playlist – Additional features ar
imported songs through the Playlist feature of SonicStage. You ca
your own list of songs categorized by genre or artist, displaying your
and arranging your songs in a customized order using the Playlist fo
multiples songs into a single one, or divide one song into two, by us
features.

❑ Simple mode – The main SonicStage window in Simple mode is 
Full mode view. This can be useful when you want to listen to songs w
software, or whenever you feel that Full mode view is intrusive. Th
window in simple mode can be changed by selecting a new “skin”, w
the window. The Simple mode feature enables you to perform play
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Using Imaging software
The following Sony imaging software are installed on your computer:

❑ Using PictureGear (page 49)

❑ Using PictureToy (page 54)

❑ Using VisualFlow (page 60)
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s, wallpapers, slide shows, personal 
f Animation Tools or play back 
ourite images and upload them to 

 When you start PictureGear for the first time, the 
t's try PictureGear window appears. It gives you 
uick overview on how to view and edit still 

ages, print various images, make a home page, 
d make stitches from a movie.

hen you start PictureGear for the first time, the 
mple slides provided with PictureGear are 
played automatically. Next time you start 
tureGear, the slides you last viewed, will be 
played.

u can always exit PictureGear by clicking the Close 

tton  in the upper right corner of the main 
ndow.
aging software

Using PictureGear
PictureGear is your assistant for creating and editing photos, background
screen savers, etc. You can even animate your preferred gif files with Gi
movies in a variety of formats. You can also create albums from your fav
a Web page.

To open PictureGear, proceed as follows:

1 Click the Start button on the Windows® taskbar.

2 Point to Programs and then PictureGear.
3 Click PictureGear.

 

✍
Le
a q
im
an

W
sa
dis
Pic
dis

Yo

bu
wi
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 or a photo album, is a collection.

e same time.
e two images you have clicked, are 

ges in the folder are selected.

.

played.
aging software

Creating a Collection
All the images and movies you use to create a slide show, a screen saver

To create a collection, proceed as follows:

1 Launch PictureGear.
The PictureGear main window appears.

2 In the Folder box, select the location of your pictures.

3 Select the pictures you want to include in your collection.
If you hold down the <Ctrl> key, you can select several pictures at th
If you hold down the <Shift> key, all the images located between th
selected.
If you press the <Ctrl> and the <A> key at the same time, all the ima

4 From the Collection menu, choose Create New Collection.
The Create New Collection dialog box appears.

5 Enter a name for your collection, then click OK.

6 Click Collection in the Folder box.
The collection you created appears under My Collection.

7 Click the picture with the left mouse button and hold the left button

8 Drag the pictures to the Collection you created.
When you click the created Collection, the selected pictures are dis
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d interval.

lay area.

s follows:

ow.

lick the left mouse button.
ther at the interval specified in 

op it.
r is displayed at the bottom of the 

yed during the Slide Show.
aging software

Viewing a Slide Show
During a slide show, images are displayed one after another at a specifie

To view a slide show, proceed as follows:

1 Create a Collection. See Creating a Collection (page 50).
2 Click Select All from the Edit menu to display all images in the disp

3 Select Slide Show View… from the View menu.
The slide show is displayed.
If you press the <Esc> key, the screen returns to the Preview area.

To change the slide show settings while viewing a slide show, proceed a

1 Click the Slideshow settings button .
The Slideshow effect dialog box appears.
There are 3 parts:

❑ Effect: here you can add sound or special effects to your slide sh

❑ Display change: you have 4 options:
If Mouse click is selected, the next slide is displayed when you c
When Automatic is selected, images are displayed one after ano
Display time.
If Repeat is selected, the slide show will repeat itself until you st
Furthermore, if the Control panel is switched on, the control ba
screen.

❑ BGM: if you select this, you can browse for a sound file to be pla

2 After choosing all the effects you want, click OK.
The slide show settings have been changed.
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vering a still image with a moving 

lay area.

d. To do this, click an image from 

 set in the Slide list is ignored and 

 images.
aging software

Creating a Screen Saver
A screen saver is a program which protects the screen by automatically co
image if the computer has not been used for a few minutes.

To create a screen saver, proceed as follows:

1 Create a Collection. See Creating a Collection (page 50).
2 Click Select All from the Edit menu to display all images in the disp

3 Select Screen Saver from the Utilities menu.
The Screen Saver Settings dialog box appears.

❑ You can arrange the images in the order you want them displaye
the Slide list and click the Up and Down buttons.

❑ If you select the Random Playing check box, the order for slides
the slides are displayed at random.

❑ You can also select effects and sound for the screen saver.

4 Click OK.
The screen saver is set.

Creating a HTML Photo Album
You can create a photo album in HTML format using slides as the source

To create a HTML photo album, proceed as follows:

1 Create a Collection. See Creating a Collection (page 50).
2 From the Utilities menu, select Album Maker.

The PictureGear Album Maker dialog box appears.

3 Choose a design template for your album.

4 Give a name to your album in Edit Title of the album.
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5 Click the Customize the design button to add pictures, frames, tex
The Panel Album dialog box appears.

6 Follow the wizard and click Finish.
PictureGear now creates your photo album.
When the process is done, the Completed dialog box appears.

❑ Click Save to select the location where you want to save your alb

❑ Click Check to display your photo album in a browser.

❑ Click Send to upload the album to the server.

❑ Click Back to create the album again.

7 Click Save.
The Select the folder to save album dialog box appears.

8 Select the folder to save the created album.

9 Click OK.
PictureGear asks if you are sure you want to create a folder.

10 Click Yes.
You get the message that the album was saved successfully.

11 Click OK.

✍ Click the Make Soon button to create your album immediately, using the PictureGear default set
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such as photographs and maps) 

p, or to overlay photographs taken 

om other Sony made software, or 

online help of PictureToy.

 button.
aging software

Using PictureToy
PictureToy allows you to superimpose pictures and texts on still images (
displayed on the desktop.
It also allows you to easily place arrows on specific areas of a computer ma
with a digital camera with illustrations.

You can select the underlay image either at the start up of PictureToy fr
directly from PictureToy.

The original image file of an underlay image remains unchanged.

To learn the names and functions of the Operation Panel, refer to the 

Starting and quitting
To start PictureToy, proceed as follows:

1 Click Start and select Programs / PictureToy / PictureToy.
PictureToy starts and the startup screen is displayed.

2 To select an underlaying image, open the image file, you 
wish to use as the underlay image, with another software. 
Then drag the icon from the main window of PictureToy, and 
drop it on the underlaying picture.
The image will be displayed in PictureToy. You can then draw 
on the picture displayed in the operation panel.

3 To draw a picture over an empty background, click the New Canvas
A new, white canvas is created on the desktop.

To quit PictureToy, proceed as follows:

Click the Quit button.
You can also click the Menu button and then click the Exit button.
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re with the Editor.
y Editor in the View menu or right 

window.

alFlow.

 on it.
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Starting from Sony applications

It is possible to start PictureToy from PictureGear and VisualFlow.

To start PictureToy from PictureGear, proceed as follows:

1 Launch PictureGear.
2 Open the image file, which you want to use as the underlaying pictu

To open a picture with the Editor, select a picture and click on Displa
click on the image and select Edit.

3 Select PictureToy from the Filter menu of the PictureGear's Editor 
PictureToy starts and you can draw on the image. 

✍ PictureGear Ver.5.0 or later must be installed to use this function. 

Refer to the PictureGear Operation Manual (Online Manual) and Help for details. 

To start PictureToy from VisualFlow, proceed as follows:

1 Launch VisualFlow.

2 Enlarge the image, which you want to use as an underlay, using Visu

3 Click the Application icon in VisualFlow.
A list of applications appears.

4 Click the PictureToy icon.
When PictureToy is running, the image is displayed and you can draw

✍ VisualFlow Ver.2.0 or later must be installed to use this function.

Refer to the VisualFlow Operation Manual (Online Manual) and Help for details.
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ens. You can also set the software 

 the line you have drawn.

r button to determine the color of 
aging software

Drawing and using pictures

Drawing freehand

You can select a variety of pens, such as magic markers, or fluorescent p
to add an arrow to the end point of a line.

To draw lines freehand, proceed as follows:

1 Click the Pen Settings button in the Operation Panel.
The display of the Details Panel changes.

2 Set the pen on the Details Panel as follows:

❑ Click the pen type you wish to use.
You can click the arrows to display more pen types. 

❑ Click the pen size you wish to use.
You can click the arrows to display more pen types. 

❑ When you click the Arrow icon, an arrow is added at the end of

3 To select the color of a line, set the color as needed and click the Colo
the line.

4 Drag the mouse pointer on the main window.
A line with the value you set, is drawn.



A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

Using Im

57

n N

oon is opened in PictureToy.

 paste balloons.
om.

r direction of a balloon is also variable.

tureToy.

nel.
aging software

Attaching stamps and balloons
In PictureToy, you can add stamps or balloons to your favorite pictures.

To attach stamps and balloons, proceed as follows:

1 Make sure the image for which you want to attach a stamp or a ball

2 Click the Stamp button to paste stamps. Click the Balloon button to
The Details Panel displays the stamps or balloons you can choose fr

3 Click the arrows to display more balloons or stamps.

4 Click the Color button to select the color of the stamp or balloon.

5 Click the position where you want to paste it.
A stamp or balloon is pasted where you clicked.

✍ You can resize, move, or rotate stamps and balloons simply by dragging their frames. The indicato

Writing text
You can use your keyboard to write text or any message on the image.
To write text on an image, proceed as follows:
1 Make sure the image to which you want to add text, is opened in Pic
2 Click the Text Input button.
3 Type the text you want to attach into the text box of the Details Pa
4 To select a different font, click the More button.

A dialog box is displayed which allows you to select fonts.
5 Click the arrows to display the font you wish to use and select it.
6 Click the Bold or Italic button to format your text.
7 Click the Color button to select the text color.
8 Click the position where you want to the text to be inserted.

The text string is inserted where you clicked.
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mit or print them.
r clipboard.

re opened.

nu displayed in the Details Panel.

rawn.
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Managing pictures

The underlaying image and the picture drawn on it can be saved togeth
JPEG or BMP format.
You can also attach PictureToy images to your e-mail message and trans
You can send PictureToy images to another software application via you

To save pictures as one PictureToy image, proceed as follows:

1 Make sure that the underlaying image and the picture drawn on it a

2 Click the Save icon.
You can also click the Menu icon and click the Save button in the me

3 Select the destination folder in the Save in list.

4 Select the file type in the Save as type list.
You can select the following types of extensions:

❑ Windows Bitmap Mix (Extension BMP)

❑ Windows Bitmap Mask (Extension BMP)

❑ JPEG Mix (Extension JPG)

❑ JPEG Mask (Extension JPG).
Mix combines the underlayed image with the picture that was d
Mask saves only the picture that was drawn.

5 Type the name of the file in the File name text box.

6 Click Save.
The picture is saved and the dialog box closes.

✍ The PictureToy image is saved as a different file, so the original underlaying remains unchanged.
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re opened.

u displayed in the Details Panel.

he Menu icon and then select Mail 

tware program.
ng methods.

o use the image on other software applications.
aging software

To print the pictures, proceed as follows:

1 Make sure that the underlaying image and the picture drawn on it a

2 Click the Menu icon and click the Print button displayed in the men
The Print dialog box appears.

3 Click OK to start printing.

To send the pictures by e-mail, proceed as follows:

To attach the picture to an e-mail, either click the e-mail button or click t
from the Details Panel.
The e-mail software starts with the PictureToy image attached.

★ PictureToy images are attached as JPEG (extension JPG) format files.

✍ To attach a PictureToy image to e-mail and send it, it is necessary to set MAPI with the e-mail sof
Refer to your e-mail software operation Manual and Help for details on attaching files and encodi

When you quit PictureToy, the image is automatically saved on the clipboard, which enables you t



A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

Using Im

60

n N

emory Stick™, your hard drive, a 
 It also allows you to select files for 

plicable) to control the display.
aging software

Using VisualFlow
VisualFlow allows you to interactively browse through files stored on a M
CD-ROM or a floppy disk that contains still images, movies or audio clips.
display or playback by other applications.
You can use the mouse, touchpad, game control or Jog Dial™ (where ap
To open VisualFlow, proceed as follows:
1 Click the Start button on the Windows® taskbar.
2 Point to Programs and then VisualFlow.
3 Click VisualFlow.

VisualFlow starts and the following screen appears.
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ter a few seconds, VisualFlow opens and displays 
mediately visible.

he MSA extension). To play audio clips that are 
 Editor must be installed on your computer.

h is connected to your VAIO computer. In order to 
 you have deleted the file or formatted the Memory 
n that case, please copy the MEMSTICK.IND file 
less the option Show hidden files and folders 

me of the displayed directory.

tton: Press to exit VisualFlow.

slide to bring it to the front. Click again to 
. 

 right mouse button or click  to 
o the previous directory.

olbar: Move the mouse across the right 
the toolbar to see more functions.

r: Use the View and Sort options to 
 the display accordingly.

nfo icon: Move the mouse across the left 
the toolbar to see detailed information 
f file, number of files, total size) on the 
y Stick™, drive, floppy, folder or CD you 
g.
aging software

 

✍ When a Memory Stick™ is inserted, the  VAIO Action Setup Countdown window appears. Af
the images found on the MemoryStick. In this case, the images on the Memory Stick™ will be im

Folders stored on a Memory Stick™ are displayed as slides.

VisualFlow cannot play audio clips that are stored as a MemoryStick Audio format (clips with t
stored as MemoryStick Voice format (files with the MSV extension), the MemoryStick Voice

If you start VisualFlow from the Start menu, VisualFlow will search for the Memory Stick™, whic
find the Memory Stick™, the MEMSTICK.IND file should be located on the Memory Stick™ itself. If
Stick™ with Windows Formatter, VisualFlow will not be able to find the Memory Stick™ device. I
from C:\Program Files\Sony\VisualFlow to the Memory Stick™. Note that this file will not appear un
is selected in Windows Explorer.

1 Path na

2 Exit bu

3 Click a 
open it

Use the
move t

4 Sub-to
end of 

5 Toolba
change

6 Drive i
end of 
(kind o
Memor
are usin
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b-toolbar and its functions:

 view.
aging software

Using the sub-toolbar
Move the mouse over the right-hand side of the toolbar to reveal the su

Click: To do this:

Sound:  

Click to turn the sound on or off.

Show folders:  

Click to show or hide the folder configuration in Memory Stick™

Blur:  

Click to enable or disable ghost trails for the moving slides.

Full-screen:  

Click to maximise the screen.

Background:  

Click to see background effects.

Help:  

Click to display the online help.

Exit:  

Click to quit VisualFlow.
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choose a different slide layout.

e slides.

ween file name, type, size and 

. Simply click the slide you want to 
ormation is displayed, including 
following icons:
aging software

Changing the view and display order
In the toolbar of VisualFlow, you can use the View and Sort options to 

❑ View buttons: Click these buttons to define a mode for displaying th

❑ Semi-circular  

❑ Checkerboard  

❑ Spiral  

❑ Linear  

❑ Sort button: Selects the order in which slides are sorted. Choose bet
time (of creation).

Displaying slide information
For the slide at the centre of the display, you can view its file information
move to the center. A red frame appears around the box and the file inf
name, size, creation date and file type. The file type is identified by the 

❑ Still image  

❑ Movie  

❑ Audio clip  
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 view or play your slide images.

ar.
mage.

online help for VisualFlow.
aging software

Using PictureGear and PictureToy with VisualFlow
You can use other Sony applications, i.e., PictureGear and PictureToy, to

To use other software, proceed as follows:

1 Launch VisualFlow.

2 Select the slide you want and click to enlarge it.

3 Click the Application icon at the bottom of the screen.

4 Click the relevant software icon, for example PictureToy or PictureGe
The selected application is launched and you can start editing your i

✍ This option is only for image or video files, not folders or other formats.

For more information on VisualFlow, such as shortcuts and enjoying your own slideshow, see the 
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hotographs taken with a digital 

photo albums, decorate your 
a.
ed from the DigitalPrint Launcher.

™ onto your computer.

your computer.

u have loaded into your computer.

oaded into your computer.
igitalPrint

Using DigitalPrint
DigitalPrint is designed to help you get the most enjoyment out of your p
camera. 
With DigitalPrint, you can easily load photos onto your computer, create 
photos, print them and even make labels for your favourite storage medi
DigitalPrint includes the following five tools. All these tools can be launch

❑ PhotoCapture: Load photos from a digital camera or a Memory Stick

❑ PhotoCollection: View and print photos that you have loaded onto 

❑ PhotoDecor: Draw on and add pictures and stamps to photos that yo

❑ PhotoAlbum: Create photo albums using the photos that you have l

❑ LabelMaker: Create labels for CDs, MDs, videotapes, etc. 
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lPrint.
gitalPrint

To launch DigitalPrint, proceed as follows:

1 In the Start menu, select Programs, DigitalPrint, and then Digita
DigitalPrint Launcher appears. 

 

2 Click Import to launch PhotoCapture
or click Photo to launch PhotoCollection
or click Edit to launch PhotoDecor
or click Album to launch PhotoAlbum
or click Label to launch LabelMaker.
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 a Memory Stick™ onto your 

y Stick™ that is connected to the 

original works (photo albums and 
h PhotoCollection. 
torage devices:

es you want to transfer to your 

 Programs, DigitalPrint, Tool, 
gitalPrint

Importing photos
Use PhotoCapture to load images that are stored on a digital camera or
computer. 
PhotoCapture can automatically recognize the digital camera or Memor
computer. 
Once photos are loaded into your computer, they can be used to create 
labels) with PhotoAlbum and LabelMaker. You can also print photos wit
PhotoCapture can load photos from the following digital cameras and s

❑ USB storage class-compatible digital cameras

❑ TWAIN-compatible digital cameras

❑ Memory Stick™.

To import photos, proceed as follows:

1 Connect a digital camera or a Memory Stick™ that contains the imag
computer.

2 Open DigitalPrint Launcher and simply click the Import icon.
You can also launch PhotoCapture from the Start menu by clicking
PhotoCapture.
The PhotoCapture window appears.
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 Photo folder icon or a camera icon.

g box and click OK.
ted Photos window. You can now 
gitalPrint

 

3 Depending on the device connected to your computer, you can click a

4 In either case, click the icon to load all the photos of the devices.
Enter a name for your photo folder in the Enter Photo Name dialo
The images are loaded into your computer and appear in the Impor
use the pictures for editing, printing, creating CD labels, etc.
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ur local photo shop to develop your 

ecify the number of prints to be 
rinting each photo separately, one 

y selecting Programs, 
gitalPrint

Printing photos
With PhotoCollection, printing photos at home is just as easy as asking yo
photos or make reprints. 
Photos stored in a folder can be printed as a group. Since you can also sp
made of each photo, you only need to run one printing job (instead of p
at a time), even if you want to give copies to a lot of people. 

To print photos, proceed as follows:

1 Click the Photo icon in the DigitalPrint Launcher. 
PhotoCollection can also be launched directly from the Start menu b
DigitalPrint, Tool, PhotoCollection.
The PhotoCollection window appears.

2 Click Register Folder to 
register a photo folder (load 
the photos into the computer) 
and follow the onscreen 
instructions or select a folder in 
which photos are stored and 
click the OK button.

3 To print photos from the 
folder, simply click the 
PhotoPrint button.
You can specify the number of 
prints and select the paper.

✍ For more information about the 
functionalities of PhotoCollection, refer to 
the online help files.
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ics, text, and stamps to digital 

os and create colourful and original 

dit icon.
ecting Programs, DigitalPrint, 
gitalPrint

Decorating photos
PhotoDecor allows you to decorate digital photos by adding lines, graph
photos. 
You can use stamps and a variety of pen patterns to decorate digital phot
works of art through simple operations. 

To decorate photos, proceed as follows:

1 Open PhotoDecor from the DigitalPrint Launcher by clicking the E
You can also launch PhotoDecor directly from the Start menu by sel
Tool, PhotoDecor.
The PhotoDecor window appears.

2 Select a photo folder that 
contains the images you 
wish to decorate and select 
one photo.

3 Use the Pen, Auto Shape, 
Text, Clip Art or Stamp 
Tool Palette to edit your 
image.

4 Print or save your edited 
picture by clicking the Print 
or Save icon.

✍ For more information on the use of 
PhotoDecor, refer to the online help.
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h a digital camera or photos you 

tes. Use these templates to easily 

ding a whole new dimension of 

Album icon.
lecting Programs, DigitalPrint, 
gitalPrint

Creating a photo album
With PhotoAlbum, you can create and print albums of photos taken wit
have loaded on your computer. 
PhotoAlbum is very simple to use. It includes many useful design templa
create an attractive album even if you have little design experience.
You can also print your album to create wonderful photo collections, ad
enjoyment to digital camera photography.

To create an album, proceed as follows:

1 Open PhotoAlbum from the DigitalPrint Launcher by clicking the 
You can also launch PhotoAlbum directly from the Start menu by se
Tool, and PhotoAlbum.
The PhotoAlbum Initial window appears. 

2 Click the Create New Album 
button and register a photo 
folder or select an existing one.
You can select all or only some of 
the photos in the album.

3 To select your images, click the 
List button in the photo folder 
and select the images in the 
Photo List dialog box. Then 
click the Create the album 
with the selected photo(s) 
button.
The Select Design window 
appears.
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.

gitalPrint

4 Select a design from the Select Design window by clicking it.
The Select Layout window appears.

5 Select a photo layout by clicking it.
The album is created and the album menu appears.

6 Use the album menu to decorate the existing albums or to print them
You can either preview the album or change the layout, or design.

✍ For more information on the use of PhotoAlbum, refer to the online help.
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abel icon.
 by selecting Programs, 
gitalPrint

Creating labels
LabelMaker is an easy-to-use label-making software. 
Use the design templates to make beautifully designed labels. 

To create labels, proceed as follows:

1 Open LabelMaker from the DigitalPrint Launcher by clicking the L
It is also possible to launch LabelMaker directly from the Start menu
DigitalPrint, Tool, LabelMaker.
The LabelMaker window appears.
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ant to create a label or edit an 

 Edit window appears.

edium, such as a CD. Then click the 

t, Clip Art or Image Tool Palette.

Gear and SonicStage.
gitalPrint

2 In the list on the side of the screen, click the medium for which you w
existing label (CDs, MDs, VHS cassettes, etc.).
The Select Paper window appears.

3 Click the paper you wish to use.
The Select Design window appears.

4 Click the design you wish to use.
The Song List (if you selected a music medium like CD or MD) or the
Edit the album and track names in the Song List window.
Create a track name list when you are creating a label for a music m
Input to the label button.

5 In the Edit window, edit the label by using the Pen, Auto Shape, Tex
6 Save or print your label by clicking the Save or Print button.

✍ For more information on the use of LabelMaker, refer to the online help.

LabelMaker can be launched and used in conjunction with other Sony applications such as Picture
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 of your computer. Among other 
d customize the look of your Sony 

 (page 91)
zing your computer

Customizing your computer
The following sections briefly describe how to change the main settings
things, you will learn how to prepare your modem for use, how to use an
software and utilities, etc.

❑ Setting up your language (page 76)

❑ Setting up your notebook with Sony Notebook Setup (page 78)

❑ Managing power with PowerPanel (page 80)

❑ Starting your favorite software with Jog Dial™ (page 86)

❑ Selecting display modes (page 89)

❑ Configuring your modem (page 90)

❑ Changing your windows design with the UI Design Selector program

❑ Setting a Sony wallpaper (page 92)
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tup of Windows for your machine.

 wizard window.

and click Next. 

click the lower Customize button. 

ut locales text box.

t in the window that appears.

n as Windows has been restarted, 

 icon.  

 locale (location). 
language from the drop-down list. 
zing your computer

Setting up your language
It is important that you select the correct keyboard settings during the Se

1 At first boot, click Next in the Windows 2000 Professional Setup
2 In the Licence Agreement window, accept the Licence Agreement 

3 To change your keyboard layout in the Regional Settings window, 
There are two Customize buttons: please select the lower one.

4 In the Input Locales tab, click the Add button in the Installed inp
5 Select your keyboard settings from the Input Locale  drop-down lis

6 Click OK.

7 In the Regional Options window, click the Set as Default button.

8 Click Apply to apply the changes, then click OK.

9 Continue your Windows setup until it is finished.

To change the country and language settings into your language as soo
proceed as follows:

1 Click Start, choose Settings, Control Panel. 
2 In the Control Panel window, double-click the Regional Options 

3 In the General tab of the Regional Options window, change Your
4 To change the language of the menus and dialog boxes, select your 
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g on again. Only then, the changes 
ust be changed for all users. Click 

d language. However, some parts 
zing your computer

5 Click Apply to apply the changes. You are prompted to log off and lo
to the new language will take effect. Click Yes if the new language m
OK in the Regional Options window.

6 Click Start, and select Log Off Administrator…. 
7 Click Yes in the Log Off Windows window.

The Log On to Windows window appears.

8 Enter your password and click OK to log on again.
All the menus, help files and icons are then displayed in your selecte
may remain in English.
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k Setup
tion, specify preferences for system 

tebook Setup.
zing your computer

Setting up your notebook with Sony Noteboo
The Sony Notebook Setup utility allows you to consult system informa
behavior, and set up password protection for your VAIO notebook.
To use Sony Notebook Setup, proceed as follows:
1 Click the Start button on the Windows® taskbar.
2 In Programs, select Sony Notebook Setup and then click Sony No

The Sony Notebook Setup window appears.
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elp file.

umber, and BIOS version.

e operating system. You can specify 
er. You can change the volume of 

n disable your touchpad. You can 
ty in this tab.

u forget the password, you cannot 
our computer.

ort settings, click Advanced on the 

nced settings) and Basic mode of 
.

zing your computer

3 Select the tab for the item you want to change.

4 Once finished, click OK.
The item has been changed.

✍ For more information about each option, click Help on the Notebook Setup screen to display the h

Tab Description

About This Computer Displays system information, including memory capacity, serial n

Printer Selects printer port mode settings.

Initial Setting Selects the drive and device order you wish to use for loading th
the hard drive as well as other drives inserted into your comput
the sounds while the operating system is loading.

Touchpad When you connect an optional mouse to your computer, you ca
also customize your mouse settings by means of the mouse utili

Power On Password Sets the password to secure your computer.
If you use this option, remember the password at all times. If yo
change this setting anymore, and you will not be able to start y

Enable Ports Disables port to release resources to the system. To change the p
Basic/Advanced tab.

Basic/Advanced Toggles between Advanced mode (additional screens with adva
display. Advanced mode includes Serial and View Resources tab
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ook and provides key information 
t selects the most advantageous 

r own needs, with the goal of 

cation;

em tray by default.
icon.

ower management profile by default. If you select 
lly be selected the next time you use the battery 
zing your computer

Managing power with PowerPanel
The PowerPanel utility controls the power management of your noteb
about system activity and battery life. The automatic power managemen
profiles, or lets you customize the profiles you choose, according to you
extended battery life.

PowerPanel has the following features:

❑ Automatic Profile Selection (APS) based on the currently active appli

❑ Ability to select specific Power Profiles manually from the menu;

❑ Ability to edit and create new profiles;

❑ Ability to display detailed battery information;

❑ It works in harmony with your Windows settings.

Activating PowerPanel
When you start the computer, the PowerPanel icon appears in the syst
To see the CPU state and the current power profile, simply point to the 

To change profiles, proceed as follows:

1 Right-click the PowerPanel icon in the taskbar and select Profiles.

2 In the Profiles menu, select a profile.
The appropriate power settings are activated.

✍ When you use the battery pack as power source, your system selects the Maximum Battery Life p
a different power management profile while using battery power, the same profile will automatica
pack to power your computer.
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. Each profile consists of a group of 
anagement goals, ranging from 

m battery life and good 
 Standby mode after a specified 

onserving power.

nel automatically loads the AC 

 Standby and Hibernate modes.
zing your computer

Activating power management profiles
PowerPanel provides several predefined power management profiles
power management settings that are designed to meet specific power m
maximum power management to no power management.

Main preset profiles

Icon Description

 

Maximum Battery Life – Provides power saving features to give you maximu
performance. It reduces the brightness of the display and puts the system into
time period.

 

Maximum Performance – Provides the best system performance while still c

 

AC Power – The power management state when AC power is in use. PowerPa
profile unless you disable this feature.

 

Power Management Off – Turns off all power management features such as
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the hard 
, Hard Disk 

es not 

s option is 
Standby, 
system.

. You can 
andby to 

.

 you 
zing your computer

Other preset profiles

Icon Description

 

Word Processing – Optimizes power management with longer timeouts on 
disk and display screen. You can also establish settings for LCD (Video) Standby
Standby, and Standby to optimize power management for your system.

 

Spreadsheet – Reduces the LCD brightness to 'medium', as your software do
require higher performance.

 

Presentation – Keeps the display on at all times while it conserves power. Thi
ideal for slideshow presentations. You can establish settings for LCD (Video) 
Hard Disk Standby, and Standby to optimize power management for your 

 

Communications – Extends battery life by initiating a quick display time-out
also establish settings for LCD (Video) Standby, Hard Disk Standby, and St
optimize power management for your system.

 

Games – Disables the display and the Hard Disk timer.

DVD – Optimizes performance and power requirements for DVD usage.

 

Camera – Optimizes performance and power requirements for camera usage

 

Automatic Profile Selection - Analyses the performance of each application
choose and matches the profiles to its needs.
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erPanel automatically selects the 
s as you switch between 

ling some energy-consuming 
izing your computer

Selecting automatic profiles
A power profile is a set of timer values for a variety of system devices. Pow
profile associated with the application you are using and changes profile
applications.
Power management lets your system enter energy saving modes by level
parameters, such as LCD brightness, or hard disk activity.

To select automatic profiles, proceed as follows:

1 Right-click the PowerPanel icon in the taskbar.

2 Select Profiles.

3 Select Automatic Profile Selection.
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Displaying detailed battery information
You can display detailed information of your computer's battery.

To display battery information, proceed as follows:

1 Double-click the PowerPanel icon in the taskbar.
The Battery Information window appears.

2 Select the Battery tab.
This tab contains information such as the estimated battery life rema

Battery icon Battery status

 

discharging: the icon is blue

 

fully charged: the icon is completely blue with an AC power plug

 

charging: the icon is blue with a red clip attached to the terminal

 

no battery: the icon is blue with a yellow cross over it



A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

Customi

85

n N

follows:

es from the menu.

ndby…) you want to modify on the 

you want to select.

es from the menu.

isplay the Power Management 

evice.
zing your computer

Editing a power profile
To edit the power management settings of a power profile, proceed as 

1 Right-click the CPU icon in the taskbar and select Edit/Create Profil
The Profile Editor window appears.

2 Click the profile you want to edit on the left of the screen.

3 Double-click the power profile property (CPU Control, Hibernate, Sta
right of the screen.
An option list or a dialog box will appear. Add or define the setting 

4 Click the File menu and then click Save.

Creating a power profile
To create a power profile, proceed as follows:

1 Right-click the CPU icon in the taskbar and select Edit/Create Profil
The Profile Editor window appears.

2 Select New from the File menu.

3 Double-click the power management setting you want to select to d
Setting menu on the right of the window.

4 Select the new power management setting you would like for the d

5 Click the File menu and then click Save.
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lso refer to the VAIO Action Setup 
zing your computer

Starting your favorite software with Jog Dial™
The VAIO Action Setup software enables you to start your favorite sof
This section briefly describes how to use VAIO Action Setup. You can a
Help for more detailed information.
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t does not support the Jog Dial™, 

d the turning direction of the Jog 
ons.

 only be shown while using the Jog 
 the window should be shown only 
rneath. Do not select the check box 

he Jog Dial™ functionality. Select 
ing the Jog Dial™ and enter the 
he Use sound when pressing 
e path and file name of the sound 

s not support the Jog Dial™. Click 
 Add, Replace, Delete buttons to 
zing your computer

Defining Jog Dial™ settings
You can select the rotation direction, allocate functions to software tha
or select the sound effects while using the Jog Dial™, etc.

1 Right-click the Jog Dial™ icon in the taskbar.

2 Select Jog Dial Setup (VAIO Action Setup) from the menu. 
The VAIO Action Setup window appears.

3 In the Advanced Setting 1 tab, set the Jog Dial™ scroll direction an
Dial™ window by selecting the Upward or Downward option butt

4 In the Advanced Setting 2 tab, define whether the window should
Dial™. Select the Show Jog Dial only when in use option button, if
while using the Jog Dial™ and enter the display time in the box unde
to see the window at all times.

5 In the Sound Setting tab, define the sound effect associated with t
the Use sound when turning check box to hear a sound when turn
path and file name of the sound in the text box underneath. Select t
check box to hear a sound when pressing the Jog Dial™ and enter th
in the text box underneath.

6 In the Application List tab, allocate functions to software that doe
the Create Folder button to define a new software folder. Click the
add, replace or delete a function in one of the software folders.
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Modifying the Jog Dial™ application list
Click Jog Dial(J) in the left part of the dialog box, and then select a folde
in the Application List. For more information on how to add, modify o
List, read the VAIO Action Setup online help.

Using the internal timer
Click Timer(T) in the left part of the dialog box, and then select the app
Timer. You can use the Internal timer to start software at a specific tim
when the computer is in Standby or Hibernate mode.
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nel.

 dialog box appears.

e same time, depending on the types of computer 

t be displayed on your TV display. You can see the 
ll image, you need to change the display resolution 

 Help.
zing your computer

Selecting display modes
This notebook uses the Mobility Radeon 7500 video controller. You can 
the notebook is connected to an external display. When you connect an e
display between your notebook's LCD and the external monitor.
Before you can select a display, you need to shut down your notebook, 
panel or monitor) to your notebook, and restart.

To select a display, proceed as follows:

1 Click the Start button, point to Settings and then click Control Pa
The Control Panel appears.

2 Double-click Display.
The Display Properties dialog box appears.

3 Click the Settings tab.

4 Click the Advanced button.
The (Multiple Monitors) and Mobility Radeon 7500 Properties

5 Click the Displays tab.
Select the Monitor, Panel or TV icon.

6 Click Apply and then OK.

✍ You cannot have a display on TV and on another display at the same time.

You may not be able to display the notebook LCD screen and an external display or a projector at th
displays and projectors you are using.

If the display resolution of your notebook is more than 800 x 600 dots, a part of the image canno
hidden area on your TV display by moving the cursor on your computer. If you want to display the fu
of your notebook to 640 x 480 dots.

Before turning on the computer, turn off the peripheral devices.

If you want more information on the ATI video controller, click the ATI icon in the taskbar and click
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ver options. As the Country 
ountry settings. Only the following 
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r VAIO computer.
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Configuring your modem
Before you can start using your internal modem, or each time you use yo
sure that the country of the active location defined in the Phone and Mo
the country you are dialing from.

You may notice a Country Selector tab under your current modem dri
Selector tab is not a constant feature, do not use this tab to change the c
procedure is reliable.

To configure your modem, proceed as follows:

1 Click Start, point to Settings and then click Control Panel.
2 Double-click Phone and Modem Options.

The Phone and Modem Options dialog box appears.

3 Select your location on the Dialing Rules tab.

4 Click the Edit button to change the current configuration.
The Edit Location dialog box appears.
Or
Click the New button to configure your modem.
The New Location dialog box appears.

5 Check the country/region settings, and make sure it matches the pla

6 If you modified your location settings, click Apply, and then OK.
The Phone and Modem Options dialog box appears.

7 Check that your modem is listed in the Modems tab.
If your modem is not listed, click Add and follow the wizard.

8 Click Apply/OK.
Your modem is configured.

✍ Before applying new country settings, please make sure your phone line is disconnected from you
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Changing your windows design 
with the UI Design Selector program
You can change the window design of Sony software compatible with t

To change the window design using UI Design Selector, proceed as follo

1 Click Start, point to Settings and then click Control Panel.
2 Double-click UI Design Selector.

The UI Design Selector dialog box appears.

3 Click << or >> and select the design you like.

4 Click Apply.
The UI Design Selector window design changes, to give you a previ
Sony software.

5 To try another design, click << or >>.

6 Click OK once you are satisfied with your choice.
The UI Design Selector dialog box disappears and changes the wind
selected.
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-down list and the Pattern option.

e on your desktop.

 adapters, for example, determine to which extend 
zing your computer

Setting a Sony wallpaper
Your Sony VAIO computer offers you, among many other features, a cho
You can change the wallpaper, the background of your desktop, as many
VAIO-specific wallpapers to choose from.

To set another VAIO wallpaper, proceed as follows:

1 Go to Control Panel.
2 Double-click the Display icon.

The Display Properties dialog box appears.

3 Click the Background tab.
A list of Windows and VAIO wallpapers is displayed.

4 Select a wallpaper.
You can see a preview of this wallpaper in the monitor above the Ba

5 Adjust the position of the wallpaper with the Picture Display drop

6 Click Apply when you have found the appropriate wallpaper.

7 Click OK to close the Display Properties dialog box.
The wallpaper is applied to your computer.

✍ A higher screen resolution reduces the size of items on your screen and increases the relative spac

You may not be able to increase the screen resolution above a certain level. Your monitor and video
you can change the resolution.
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Installing and updating applications
This section explains how to install, run or uninstall a software.
Furthermore, you will learn how to download the latest updates from o

❑ Installing software (page 94)

❑ Changing or removing software (page 95)

❑ Uninstalling software (page 96)

❑ Downloading software (page 97)
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Installing software
Before installing the applications:

❑ Install and connect a hardware device, if necessary (see the Managin
❑ Quit all Windows® programs.

To install an application, proceed as follows:

1 Click Start, point to Settings and then click Control Panel.
2 Double-click Add/Remove Programs in Control Panel.

The Add/Remove Programs dialog box appears.
3 Click Add New Programs, and then click CD or Floppy.

The Install Program From Floppy Disk or CD-ROM window appe
4 Insert the first installation floppy disk or CD-ROM and click Next.

The Run Installation Program appears.
5 Click Browse… to find the installation program.

The Browse window appears.
6 Select the installation program and click Open.

The path of the installation program appears in Open: text box.
7 Click Finish.

A License Agreement dialog box might appear.
8 Read the agreement and click Yes to accept.

You are asked to define the location where you want to install the s
9 Click Browse to select the folder and click Next.

If necessary, select the type of installation you wish and click Next.
The software installation begins.
Make sure to select Yes, I want to restart my computer now if y

10 Click Finish.
Installation is complete and your computer restarts.

✍ When using Add/Remove Programs, you can only install programs that were written for Windo
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Changing or removing software
You can at all times remove or change a software application.

To change or remove a software, proceed as follows:

1 Click Start, point to Settings, click Control Panel, and then click A
2 Select the software you want to change or remove.

❑ To change a program, click Change/Remove or Change.

❑ To remove a program, click Change/Remove or Remove. 

! When you click Change or Remove, some programs may be removed without any further warni

✍ You can sort programs by selecting different options in Sort by.

Add/Remove Programs will only remove programs that were written for Windows® operating 
documentation to see if other files (such as .ini files) should be removed.



A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

Installin

96

n N

alled programs, then click Change/

mputer restarts once uninstallation 

that you click No to keep shared 
g and updating applications

Uninstalling software
Before proceeding, close the application you want to uninstall.

To uninstall software, proceed as follows:

1 From the Start menu, point to Settings and click Control Panel.
The Control Panel window appears.

2 Double-click the Add/Remove Programs icon.
The Add/Remove Programs dialog box appears.

3 Select the software you wish to uninstall from the list of currently inst
Remove.
The Confirm File Deletion dialog box appears.

4 Click OK.
If the Locked file detected dialog box appears, click Reboot. The co
is completed and all previously used files are deleted.
If the Shared file detected dialog box appears, it is recommended 
files.

5 Click Finish.
The software is uninstalled.
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Downloading software
Please note it is possible to download the latest upgrades of software fo
Just click the following link to access it: www.vaio-link.com

To download the latest upgrades, proceed as follows:

1 Go to www.vaio-link.com and choose your language.

2 Fill in the two codes and click Enter Site.

3 Select Downloads and follow the procedure.
A list of available downloads appears.

4 Choose the appropriate upgrade and follow the online instructions t

✍ To install your application, see the Installing software (page 94) section.

www.vaio-link.com
www.vaio-link.com
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Managing drivers
A driver is a software enabling you to use hardware devices. For example
a printer, you must first install its driver. Many drivers, such as the mous
system.

This section explains how to install, check, update or uninstall a driver.
Finally, you will learn how to download the latest drivers from our VAIO

❑ Installing a driver (page 99)

❑ Checking the driver's installation (page 100)

❑ Updating a driver (page 101)

❑ Uninstalling a driver (page 102)

❑ Downloading drivers (page 103)
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 the CD-ROM accompanying the 

g a CD-ROM (or disk) drive 
 (or disk) drive.

ided CD-ROM (or disk) to your hard 
e subdirectory should be found in 

nt.
g drivers

Installing a driver
To install a driver, proceed as follows:

1 Insert the application CD-ROM into the CD-ROM drive (or the disk or
device you want to configure).

2 Connect the device that needs a driver, to your computer.
The Found New Hardware Wizard screen appears.

3 Select Specify a location, then click Next.

4 When installing a driver from the provided CD-ROM (or disk) by usin
connected to the computer, select the Drivers folder on the CD-ROM

5 When installing a driver after having copied the contents of the prov
disk, browse to the appropriate subdirectory containing the driver. Th
the folder you copied from the CD-ROM (or disk).

6 Click OK to begin the search procedure.

7 Click Next to install the driver.
A new window appears when the driver has been installed.

8 Click Finish.
You may be asked to restart your machine.

9 Click Yes.
The driver is installed.

✍ To install your device driver, you must be logged on to your computer with an administrator accou
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en double-click your device.

splayed under Device status.

 exclamation mark.
in Installing a driver (page 99).
st does not display your device.
er (page 102) to remove it. Then 

 step 2 in Installing a driver 

he device is not working properly.
 as follows:
g drivers

Checking the driver's installation
When the computer restarts, verify that the device is working properly.

To verify the driver’s installation, proceed as follows:

1 From the Start menu, point to Settings and then click Control Pan
The Control Panel window appears.

2 Double-click the System icon.
The System Properties dialog box appears.

3 Click the Hardware tab, then click Device Manager.
4 Double-click the option corresponding to the device you installed, th

The Properties dialog box appears.

5 Make sure that the This device is working properly message is di

6 Click OK.
Close all the opened windows, your device is ready for use.

The device is not working properly in the following cases:

❑ Your device is shown in Device Manager with a yellow question or
Right-click your device and click Uninstall. Then repeat from step 2 

❑ Double-clicking the category of your device in the device manager li
You have to remove your device. Please refer to Uninstalling a driv
repeat from step 2 in Installing a driver (page 99).

❑ Double-clicking Other devices displays your device.
You have to right-click your device, then click Uninstall. Repeat from
(page 99).

❑ If the This device is working properly message is not displayed, t
Click OK to close the Properties dialog box, then reinstall the driver
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ice is not working properly.
 installation. Click your device, then 
er. When the computer restarts, 

dows search for the driver, or point 
g drivers

❑ Right-click Uninstall.
❑ When the Confirm Device Removal dialog box appears, click O
❑ Click Yes and restart the computer.

❑ When the computer restarts, repeat from step 2 in Installing a d
❑ If your device is not displayed in the Properties dialog box, the dev

Repeat steps 1 through 4 in the previous sections to verify the driver’s
click Uninstall to remove the driver. Click Yes to restart the comput
repeat from step 2 in Installing a driver (page 99).

Updating a driver
To update the driver, proceed as follows:

1 Click Start on the taskbar and point to Settings.

2 Click Control Panel.
3 Double-click the System icon.

The System Properties dialog box appears.

4 On the Hardware tab, click Device Manager.
The Device Manager screen appears.

5 Right-click the hardware and select Properties.
The Properties dialog box appears.

6 On the Driver tab, click Update driver.
7 Follow the instructions that appear on your screen. You can have Win

to the driver's location yourself.
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Uninstalling a driver
Leave the device connected to your computer while uninstalling the driv

To uninstall the driver, proceed as follows:

1 Click Start on the taskbar and point to Settings.

2 Click Control Panel.
3 Double-click the System icon.

The System Properties dialog box appears.

4 On the Hardware tab, click Device Manager.
The Device Manager screen appears.

5 Right-click the hardware and select Properties.
The Properties dialog box appears.

6 On the Driver tab, click Uninstall.
7 Follow the instructions that appear on your screen. You can have Win

to the driver's location yourself.
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Downloading drivers
Please note it is possible to download the latest versions of drivers for yo
Just click the following link to access it: www.vaio-link.com

To download the latest drivers, proceed as follows:

1 Go to www.vaio-link.com and choose your language.
When you access the VAIO-Link for the first time, the Web Disclaim

2 Fill in the two codes and click Enter Site.

3 Select Downloads and follow the procedure.
A list of available downloads appears.

4 Choose the appropriate driver and follow the online instructions to 
To install your driver, follow the instructions you downloaded with t

www.vaio-link.com
www.vaio-link.com
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 In the event that the original data 
essible because of a hard disk 

. 

ckup.

or changes (new program installation, …).

 change or delete this folder.

es in a folder within your system root/repair folder. 

d online book in Introducing 
 an Emergency Repair Disk (ERD)

Creating an Emergency Repair Disk (ERD
The backup utility helps you create a copy of the data on your hard disk.
on your hard disk is accidentally erased or overwritten, or becomes inacc
malfunction, you can use the copy to restore your lost or damaged data

To create an Emergency Repair Disk, proceed as follows:

1 Click Start.

2 Point to Programs, Accessories, then System Tools and finally Ba
The Backup window appears.

3 From the Tools menu, choose Create an Emergency Repair Disk.
4 Follow the instructions that appear on your screen.

✍ You will need a blank 1.44 MB floppy disk to create an Emergency Repair Disk.

It is recommended to recreate an Emergency Repair Disk each time your computer undergoes maj

The repair process relies on information that is saved in the system root/repair folder. You may not

Choosing Also back up the registry to the repair directory, will save your current registry fil
This is useful if you need to recover your system in the event your hard disk has failed.

Additional information on the repair process is available in the help files (see the Getting Starte
Windows® 2000 Professional).
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 on any other Sony PC or other manufacturer's PC.

 applications that were preinstalled 
ix the problems encountered if it 
ning a device.

s® has booted up.
e product recovery CD-ROMs

Using the product recovery CD-ROMs
The Product Recovery CD-ROMs supplied with your computer allow you 
and help you reinstall individual applications and device drivers manuall

❑ Perform an Application Recovery to:

❑ Reinstall an individual driver if a device is not functioning proper

❑ Reinstall an individual application if you have problems running 

❑ Perform a System Recovery in the following cases:

❑ In the event of a serious system crash.

❑ If you want to modify the size of the hard drive partitions.

! You can only use these product recovery CD-ROMs on the Sony computer they came with and not

❑ Performing an application recovery (page 105)

❑ Performing a system recovery (page 107)

❑ Aborting the system recovery process (page 112)

Performing an application recovery
The final CD in the set of product recovery CD-ROMs contains most of the
on your computer. Reinstalling a program from this application CD can f
does not run correctly anymore, or if Windows® is having a problem run

To perform an application recovery, proceed as follows:

1 Turn on your computer (using AC power only) and wait until Window

2 Insert the final product recovery CD-ROM into the disc drive.

3 Open the drive through My Computer and open the Apps folder.
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ncountered if Windows® is having 

se see Managing drivers 

s® has booted up.

r.

 device you want to update.
e product recovery CD-ROMs

4 Open the folder of the application you want to reinstall.

5 Double-click the Setup file.

6 Follow the instructions in the Installer.

✍ You must run the final product recovery CD-ROM from Windows®.

The application recovery does not run from DOS.

When performing an application recovery, you do not lose any data on your hard disk.

In most cases, you are advised to uninstall an application before reinstalling it.

Reinstalling a device driver from the application CD
Some applications or peripherals require specific drivers which are not fo
system. 

The final CD in the set of product recovery CD-ROMs contains the driver
hardware devices. Reinstalling a driver from this CD can fix the problems e
a problem running a device. For more details on managing drivers, plea
(page 98).

To reinstall/update a device driver, proceed as follows:

1 Turn on your computer (using AC power only) and wait until Window

2 Insert the final product recovery CD-ROM into the disc drive.

3 Open the drive through My Computer and open the Drivers folde

4 Check that the driver you require appears in the folder.

5 Click Start on the taskbar.

6 Click Control Panel, then System.

7 On the Hardware tab, select Device Manager and double-click the

8 On the Driver tab click Update Driver.
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Windows® search for the driver, or 

 your computer.
ndows® does not work as it should, 
reinstall the originally configured 

 the partitions altogether.
n both C: drive and D: drive will be 

u will be prompted to change CDs.

ot work for the software you have 

choose to only recover Windows®.

(not to the battery) before you 

e recovery CD-ROM from the drive 

ot be docked (you must disconnect 
tion).
e product recovery CD-ROMs

❑ Follow the instructions that appear on your screen. You can have 
point to the driver's location yourself.

Performing a system recovery
The system recovery process allows you to:

1 Reinstall an image of the hard disk as it was before you started using
In the event that your system is seriously damaged, for example, if Wi
or your PC behaves abnormally, the system recovery will completely 
system on your C: drive.

2 Change the sizes of the two available hard drive partitions, or delete
If you decide to modify the size of your partitions, the existing data o
deleted (see Using partitioned drives (page 108)).

Notes on performing a system recovery
❑ The recovery process can last up to sixty minutes, and in this time yo

❑ You can recover only the software bundled to your computer. It does n
installed subsequently or the data you have created. 

❑ This procedure recovers the entire system, which means you cannot 

❑ Make sure that your computer is connected to the AC power supply 
attempt a system recovery.

❑ When the recovery is performed, you are recommended to remove th
before restarting the computer.

❑ Notebooks only: To perform a system recovery, the notebook should n
the docking station*, unless your CD-ROM drive is on the docking sta

* Depending on your model.
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rtitions (C: and D:). Your hard disk 
n that your computer contains two 

as C: drive) contains all the files 
e is empty. The D: drive is the ideal 
 digital motion pictures captured 

 C: drive only, this option is not recommended for 

s and files to the D: drive. Moreover, doing so will 

s might delete all your files on the hard disk.

 disk, copy all the files you want to keep on the D: 
 so will keep your D: drive unchanged after the 

in the system recovery set-up process. In this case, 
ting files, make sure you back them up before 

em recovery CD-ROM into the disc 

art/TShut Down.../Shut Down)*.
e product recovery CD-ROMs

Using partitioned drives
In My Computer you may have noticed the availability of two drive pa
drive comes from the factory with 2 logical partitions. This does not mea
physical hard disks.

When you start using your computer, your C: partition (also referred to 
required by Windows® and other pre-installed software, while the D: driv
storage space for all your documents and files, especially larger ones like
by DVgate.

✍ Although you can perform a system recovery and change the partition settings in order to have one
using video editing applications like DVgate.

To optimise data storage, use the C: drive to install new applications, and save all your document
prevent the loss of your data in case you need to perform a system recovery.

Do not try to add, delete, or resize partitions unless you really need to. Changing partition setting

If you need to perform a system recovery, but do not want to lose all the data stored on your hard
drive. During the system recovery process, choose to keep the current partition information. Doing
recovery process.

If you do need to change the size of your partitions, you can do so by choosing Option Recovery 
it is important to be aware that all data on your hard disk will be deleted. If you need to keep exis
performing the system recovery.

Starting the system recovery procedure
To start the system recovery, proceed as follows:

1 Turn on your computer (using AC power only) and insert the first syst
drive.

2 If you are still able to access Windows®, shut down your computer (St
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 wait.

e to turn off the computer by pressing the 
on again to turn the power on.

izes
 computer without changing the 

Recovery. Performing this recovery 
 your D: drive will remain.

mended).
e product recovery CD-ROMs

3 Wait 10 seconds then turn the computer back on.

4 The system starts to read the CD automatically and you are asked to

5 Click Next in the window that appears.

6 Read the introduction and click Next.
You can now choose the nature of the recovery.

* If your system is severely damaged and you can no longer access Windows®, you will hav
power button for longer than four seconds. Wait for ten seconds before pressing the butt

Recovering the system without changing partition s
To completely restore the original software, drivers and settings on your
partition sizes, choose the first option and apply a Default System Drive 
means that you will lose all the data stored on your C: drive, but data on

You should allow one hour for the recovery process.

To perform the Default System Drive Recovery, proceed as follows:

1 Select the button next to Default System Drive Recovery (Recom
2 Click Next.

You are asked if you are sure you want to recover the system.

3 To start the procedure, click Next.

4 Click Yes to confirm.
The recovery process starts.

5 When asked to do so, remove the CD and insert the next one.

6 When the process is finished, click OK.

7 Click Next in the window that appears.



A
b

o
u

t 
th

e
 s

o
ft

w
a
re

 o
n

 y
o

u
r 

S
o

n
y
 n

o
te

b
o

o
k

Using th

110

n N

ly.

oring the original software, drivers 

se all the data stored on both your 

thout changing partition sizes 

 select the size of your C: drive, 
artition sizes are deleted, the hard 
ndard system recovery.
e product recovery CD-ROMs

8 Remove the CD from the drive and click Finish.
Your system is restored to its initial settings and reboots automatical

Recovering the system with modified partition sizes
To have the option of changing the partition sizes before completely rest
and settings on your computer, choose Option Recovery.

Changing the partition sizes of the two hard drives means that you will lo
C: drive and your D: drive.

You should allow one hour for the recovery process.

To perform a recovery with options, proceed as follows:

1 Select the button next to Option Recovery.

2 Click Next.
You now have three options:

❑ Default System Drive Recovery, (see Recovering the system wi
(page 109)).

❑ Change Partition Size and Recover.

❑ Recovery To Originally Shipped State.

Manually changing partition sizes

Choosing Change Partition Size and Recover allows you to manually
leaving the remaining gigabytes to the D: drive. Meanwhile, all current p
disk is reformatted, and all the original software is restored as with a sta

You should allow one hour for this process.
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roceed as follows:

oose to restore the default size by 

d click Next to start the process.

matically.

choosing Recovery To Originally 
anwhile, the current partitions are 
tored as with a standard system 

d click Next to start the process.
e product recovery CD-ROMs

To manually change the partition sizes and perform a system recovery, p

1 Select the button next to Change Partition Size and Recover.
2 Click Next.

3 In the following screen, set the size of your C: drive in gigabytes, or ch
pressing Default.

4 Click Next.

5 Read the summary of the recovery process about to be performed an

6 Click Yes to confirm.

7 When asked to do so, remove the CD and insert the next one.

8 When the process is finished, click OK.

9 Click Next in the window that appears.

10 Remove the CD from the drive and click Finish.
Your system's settings are changed and your computer reboots auto

Resetting the default partition sizes

If you changed the partition sizes since you bought your Sony computer, 
Shipped State allows you to reset the hard drive to its original size. Me
deleted, the hard disk is reformatted, and all the original software is res
recovery.

You should allow one hour for the recovery process.

To restore the default size of the hard drive, proceed as follows:

1 Select the button next to Recovery To Originally Shipped State.

2 Click Next.

3 Read the summary of the recovery process about to be performed an
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ly.

ility makes it easy to cancel any 
 data that will incur and you can 
ery setup altogether. To abort, 

lete all the current data on your C: 
 data on both hard drive partitions.
e product recovery CD-ROMs

4 Click Yes to confirm.

5 When asked to do so, remove the CD and insert the next one.

6 When the process is finished, click OK.

7 Click Next in the window that appears.

8 Remove the CD from the drive and click Finish.
Your system is restored to its initial settings and reboots automatical

Aborting the system recovery process
Before the actual recovery process begins, the VAIO System Recovery Ut
settings you may have made. Most screens remind you about the loss of
either to go back to the previous screen (press Back), or abort the recov
remove the recovery CD, press Cancel, and click Yes to confirm.

However, once the recovery process has started, canceling the job will de
drive. If you have made changes to the partition settings, you will lose all

If you do not remove the CD before pressing Cancel, the system recovery will start again.
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